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Resumo
A Terra sofre a ameça contínua de colisão com objetos cósmicos, sejam eles asteroides ou
cometas. A denominação dos Objetos Próximos à Terra, ou Near Earth Objects, comu-
mente referidos por NEOs, agrupa os asteroides e cometas que permeiam a vizinhança
terrestre. Apesar da maioria desses corpos não oferecer riscos significativos de impactos,
existe uma parcela não nula que pode entrar em rota de colisão com a Terra e causar
inúmeras destruições. Com isso, uma área da ciência voltada para a defesa planetária tem
constantemente estudado e desenvolvido tecnologias para conter eventos em que uma coli-
são com um NEO é provável. A principal estratégia de defesa se dá por meio do desvio de
um corpo que esteja viajando em direção à Terra através da utilização de tecnologias de
mitigação. Entre essas tecnologias, os impactadores cinéticos se destacam por sua aplica-
ção e eficiência, e neste contexto, a primeira missão focada em demonstrar essa tecnologia
na prática, a Double Asteroid Redirection Test, ou DART, foi lançada em 2021. O obje-
tivo deste trabalho é fazer uma análise do problema da deflexão de asteroides com foco
em impactadores cinéticos, utilizando parâmetros reais da missão DART para análises de
dinâmica orbital.

Palavras-chaves: dinâmica orbital, deflexão de asteroide, NEO, missão DART.





Abstract
Earth is under a continuous threat of collision with cosmic objects, whether they are as-
teroids or comets. The designation Near-Earth Objects (NEOs) groups together asteroids
and comets that move within Earth’s vicinity. Although most of these bodies do not pose
significant impact risks, a non-negligible fraction may enter a collision course with Earth
and cause widespread destruction. As a result, a branch of science dedicated to planetary
defense has been actively studying and developing technologies to prevent events where a
collision with an NEO is likely. The primary defense strategy involves deflecting a body
traveling toward Earth using mitigation technologies. Among these technologies, kinetic
impactors stand out for their applicability and efficiency. In this context, the first mis-
sion specifically designed to demonstrate this technology in practice, the Double Asteroid
Redirection Test (DART), was launched in 2021. The objective of this study is to ana-
lyze the asteroid deflection problem with a focus on kinetic impactors, using real mission
parameters from DART to conduct orbital dynamics analyses.

Key-words: orbital mechanics, asteroid deflection, NEO, DART mission.
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1 Introdução

A Terra está situada em um ambiente que por muitas vezes pode ser hostil. Desde
sua formação, nos primórdios do Sistema Solar, ela sempre foi alvo de outros corpos que
estão presentes no espaço, como asteroides e cometas. Nos piores cenários de colisão com
estes objetos cósmicos, todo o curso evolutivo da vida que habitava o planeta foi alterado,
assim como sua ecosfera e suas condições climáticas. Nesse cenário, a humanidade se vê
vulnerável a um tipo de ameaça vinda dos céus.

Ao longo dos anos, com o desenvolvimento do conhecimento sobre o espaço e suas
leis fundamentais, a comunidade científica dedicou-se a estudar e identificar estes corpos
que poderiam se tornar uma ameaça à toda a população global. Embora a humanidade
tenha avanços muito significativos na identificação de objetos cósmicos, ainda é impra-
ticável a identificação de absolutamente todos os corpos que existem no Sistema Solar,
mesmo que uma grande parcela desses objetos seja conhecida atualmente.

Apesar de grandes eventos de colisões com asteroides e cometas serem raros em
um período que abrange a existência humana, eles estão distribuídos na escala de tempo
geológica de forma aleatória, e podem vir a ser impredizíveis. Diante da imprevisibilidade e
do grau de incerteza que permeia a discussão sobre impactos com estes objetos cósmicos, a
comunidade científica voltou-se para o estudo e desenvolvimento de tecnologias que sejam
capazes de mitigar esses eventos e prevenir a Terra de sofrer com impactos que possam
ser destrutivos em escalas regional ou mesmo global, e consequentemente salvar a vida de
milhares de pessoas.

Com isso, estratégias de defesa planetária têm sido discutidas e desenvolvidas, nas
quais o foco principal é a deflexão de um corpo que esteja em rota de colisão com a Terra
de forma que sua trajetória seja alterada e ele seja desviado. A partir desse ponto, o
planejamento e lançamento de missões espaciais que venham demonstrar e comprovar a
ação e efetividade dessas novas tecnologias tornaram-se um objetivo real. Desta forma,
a primeira missão do mundo com o objetivo de validar uma tecnologia de deflexão de
asteroides, a Double Asteroid Redirection Test ou DART ocorreu entre 2021 e 2022.

O presente trabalho visa o estudo do ponto de vista da mecânica orbital do pro-
blema de interceptação e deflexão de asteroides aplicada à arquitetura da missão DART.

1.1 Objetivo Geral

O objetivo geral desde trabalho é o estudo teórico da dinâmica orbital em mis-
sões de redirecionamento de asteroides, com ênfase no método de deflexão por meio de
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impactadores cinéticos.

1.2 Objetivos Específicos
Os objetivos específicos do presente trabalho são:

• Estudo das tecnologias existentes de redirecionamento de asteroides e cometas.

• Modelagem matemática do problema de interceptação e deflexão de asteroides.

• Modelagem de trajetórias da missão DART em software de simulação de missões
aeroespaciais.

• Análise de dados obtidos e comparação com parâmetros reais da missão.

1.3 Metodologia
O presente trabalho desenvolve-se por meio de uma revisão bibliográfica e funda-

mentação teórica dos principais conceitos que abrangem o problema de redirecionamento
de asteroides, as principais tecnologias existentes atualmente, os conceitos de dinâmica
orbital que descrevem este problema do ponto de vista físico e matemático, bem como
simulações computacionais para análise de missões espaciais.

1.4 Justificativa
O desenvolvimento deste trabalho tem como justificativa a possibilidade da Terra

ser atingida por corpos que podem causar inúmeras destruições e a necessidade do desen-
volvimento de técnicas que sejam utilizadas como mitigação desses cenários destrutivos.
Além disso, o cenário atual em que missões espaciais de redirecionamento de asteroi-
des estão sendo colocadas em prática é propício para o estudo, validação e avaliação da
efetividade dessas novas tecnologias em um cenário real de colisão com um asteroide.

1.5 Organização do Trabalho
Este trabalho é organizado em três seções. A primeira seção corresponde aos as-

pectos gerais do trabalho, seus principais objetivos e metodologia. A segunda seção cor-
responde à contextualização, fundamentação teórica, e desenvolvimento dos conceitos que
descrevem o problema principal a ser discutido. A terceira seção corresponde às simulações
computacionais, análises de resultados, e considerações finais.
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2 Contextualização

2.1 Objetos Próximos à Terra (NEOs)

A definição de Objetos Próximos à Terra (Near-Earth Objects ou NEOs) corres-
ponde a um grupo de corpos celestes, como cometas e asteroides, que sofrem a ação da
atração gravitacional de planetas do sistema solar e são redirecionados a órbitas que in-
terceptam a vizinhança terrestre. Tal proximidade à Terra gera riscos de impactos e a
necessidade da constante observação e monitoramento destes corpos, assim como o desen-
volvimento de estratégias capazes de impedir ou mitigar possíveis colisões. (COLOMBO,
2010; CNEOS. . . , )

Asteroides e cometas são destroços remanescentes do processo de formação do
Sistema Solar, ocorrido há cerca de 4,6 bilhões de anos, que estão presentes nele orbitando
o Sol. Os cometas são corpos formados majoritariamente por gelo e partículas de poeira
localizados na região externa mais fria do sistema planetário, e são oriundos do processo de
formação dos planetas gigantes gasosos Júpiter, Saturno, Urano e Netuno, que ganharam
forma a partir da aglomeração de bilhões de cometas. Asteroides são corpos rochosos
oriundos do processo de formação dos planetas na região interna mais aquecida do Sistema
Solar, sendo eles Mercúrio, Vênus, Terra e Marte. Enquanto os asteroides estão presentes
em sua grande maioria na região entre as órbitas de Marte e Júpiter, os cometas estão
presentes no Cinturão de Kuiper, região localizada além da órbita de Netuno até 55 UA
do Sol. (COLOMBO, 2010; CNEOS. . . , )

Os corpos identificados como NEOs orbitam a uma distância de periélio de até 1,3
UA, e viajam em altas velocidades relativas à velocidade da Terra, variando em tamanho
de pequenas pedras a quilômetros de comprimento. Dentre este grupo está o subgrupo
composto por asteroides denominado Asteroides Próximos à Terra (Near-Earth Asteroids
ou NEAs). (COLOMBO, 2010; CNEOS. . . , )

2.2 Riscos de Impacto e Defesa Planetária

A ocorrência de grandes impactos de asteroides com a Terra marcou o processo
de formação geológica do planeta a ponto de interferir significativamente em sua ecosfera
e na evolução da vida terrestre. Grandes eventos que ocorreram ao longo de milhares de
anos são baseados em hipóteses e evidências de colisões com asteroides ou cometas, como
por exemplo a extinção em massa da vida que habitava o planeta no período Cretáceo-
Terciário, tal como os dinossauros, em decorrência de uma colisão catastrófica com um
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asteroide, ou como por exemplo a formação da Lua por meio de uma colisão entre um
corpo aproximadamente do tamanho de Marte e a Terra. (CHAPMAN; MORRISON,
1994)

Uma vez que estes eventos astronômicos de grande impacto possuíram e ainda
possuem uma influência significativa sobre o curso evolutivo da vida terrestre, discus-
sões sobre colisões que possam vir a ocorrer nos dias atuais estão sempre presentes no
meio científico, bem como o estudo e desenvolvimento de possíveis estratégias de defesa
planetária para a mitigação de danos ou ainda o evitamento de um evento deste tipo.

Uma colisão de um NEO com a Terra pode ser potencialmente destrutiva se houver
riscos de efeitos devastadores sobre uma determinada região do planeta ou de catástrofes
globais provenientes do impacto. A indicação de riscos de possíveis impactos de NEOs
com a Terra e a análise de suas consequências dependem da determinação das órbitas
desses objetos e da estimativa do quão perto eles podem chegar da Terra, entretanto, a
determinação de suas órbitas ocorre a partir de uma aproximação de dados coletados com
as posições dos corpos observadas no céu, já que esses dados não são exatos. Dentre a
categoria dos NEOs está a subcategoria dos Objetos Potencialmente Perigosos (Potentially
Hazardous Objects ou PHOs), que estão orbitando a uma distância inferior a 0,05 UA da
órbita terrestre e possuem uma probabilidade de colisão com a Terra diferente de zero.
(COLOMBO, 2010; CNEOS. . . , )

Diante de um cenário passível de uma colisão, a probabilidade da Terra sofrer
um impacto com um corpo de magnitude suficiente para causar uma perturbação des-
comunal no ecossistema global, ou atingir grandes áreas urbanas a ponto da população
mundial ser reduzida ou mesmo dizimada, é consideravelmente baixa, sendo estimada em
1 a cada 10.000. A avaliação de possíveis danos causados por impactos cósmicos é depen-
dente da magnitude e da energia do corpo, asteroide ou cometa, que venha a cruzar a
órbita terrestre, uma vez que objetos com diâmetro inferior a 50 m e com energia inferior
a 10 megatons sofrem uma dissipação de energia e são desintegrados ao adentrarem a
atmosfera superior. Objetos maiores que 50 m de comprimento podem causar danos lo-
cais dependendo de circunstâncias como a região que eles atingem, velocidade, ângulo de
entrada na atmosfera e da composição desses corpos. Para que uma catástrofe de ordem
global ocorra, a magnitude que um objeto precisa ter é estimada entre 0,5 e 5km, embora
não se saiba ao certo o tamanho exato que este corpo deve ter para que seja capaz de
causar destruições. (CHAPMAN; MORRISON, 1994; NEOMAP, 2004)

A estimativa para a ocorrência de impactos cósmicos depende do fluxo de cometas
e asteroides que atingem a Terra. Estes asteroides são majoritariamente fragmentações
rochosas e metálicas, provenientes de colisões ocasionadas na região do Cinturão de As-
teroides, e atingem a Terra a uma velocidade aproximada de 20 km/s. Já os cometas
possuem uma velocidade mais alta em comparação aos asteroides, variando de 30 a 60
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km/s, porém ocorrem em menor frequência. Estatisticamente, objetos maiores que 1 km
são quantificados em 1000, o que os torna raros em ocorrência, enquanto que objetos
maiores que 40 m são quantificados em mais de 1 milhão, cuja frequência de impacto está
em torno de centenas de anos. (CHAPMAN; MORRISON, 1994; COLOMBO, 2010)

Apesar da possibilidade de cometas colidirem com a Terra ser expressiva, esses
objetos estão, de modo geral, fora do escopo de missões para mitigação de colisões, uma
vez que eles são constituídos por uma estrutura porosa e frágil e viajam em velocidades
relativamente altas capazes de gerar um alto potencial de impacto, o que os torna difíceis
de serem mitigados considerando as tecnologias atuais existentes e curto período de tempo
em que podem ser detectados, levando-se em consideração cometas de longo período.
Ainda, a ocorrência de cometas é consideravelmente menor do que a de asteroides, sendo
assim, 99% do total de NEOs existentes e da probabilidade de impactos são referentes aos
asteroides. (NEOMAP, 2004)

É possível correlacionar o fluxo de impacto de asteroides com a quantidade de
energia liberada durante a colisão e com a incidência temporal que estes eventos ocorrem.
Esta relação é mostrada no gráfico abaixo:

Figura 1 – Fluxo de Asteroides. Fonte: (CHAPMAN; MORRISON, 1994)
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O gráfico acima demonstra como a magnitude de um asteroide se relaciona com
o intervalo de tempo em que esses corpos atingem a Terra e quantidade de energia equi-
valente à liberada em explosões, que a colisão com eles libera. Dois grandes eventos de
impacto com asteroides são marcados no gráfico como parâmetro: o evento de Tunguska,
em que a queda de um corpo celeste sobre a região da Sibéria, em 1908, causou uma
devastação sobre uma área maior que 1000 km2; e o impacto que teria causado a ex-
tinção em massa de inúmeras espécies no período Cretáceo-Terciário, indicado por K/T
(Cretaceous/Tertiary). (CHAPMAN; MORRISON, 1994)

Com base nos dados existentes que descrevem a ocorrência de impactos com as-
teroides, é possível também correlacionar os eventos resultantes de tais episódios com a
ocorrência de impactos e tamanho dos objetos em questão. Entretanto, uma análise mais
apurada deve levar em consideração a energia cinética do corpo, que depende intrinseca-
mente de sua massa e velocidade. (NEOMAP, 2004)

A tabela a seguir mostra esta correlação entre a dimensão do objeto e frequência
de impacto, os eventos passíveis de se ocorrer, o diâmetro da cratera formada caso o
corpo atravesse a atmosfera sem sofrer desintegração significativa e atinja o solo, e a
energia liberada considerando um corpo celeste rochoso de densidade de 3500 kg/m3 e
uma velocidade de impacto de 20 km/s (NEOMAP, 2004):

Tabela 1 – Frequência de impactos e eventos resultantes

Dimensão
do Objeto
(m)

Intervalo
médio de
impacto
(anos)

Energia
liberada
(megatons
TNT)

Diâmetro
da cratera
formada
(km)

Consequências possíveis/Eventos com-
paráveis

30 200 2 - Danos menores, ondas de choque e bo-
las de fogo.

50 2500 10 ≤ 1 Explosão equivalente ao Evento de
Tunguska ou crateras menores.

100 5000 80 2 Maior detonação de Bomba de Hidro-
gênio.

200 47.000 600 4 Destruição em escala nacional.
500 200.000 10.000 10 Destruição em escala continental.
1000 600.000 80.000 20 Milhões de mortes, efeitos globais.
5000 20 milhões 10 milhões 100 Bilhões de mortes, mudança climática

global.
10.000 100 milhões 80 milhões 200 Extinção da civilização humana.

Fonte: (NEOMAP, 2004)

A massa de um NEO pode ser estimada a partir de sua magnitude absoluta H,
um parâmetro que mede a magnitude aparente, ou seja, o brilho intrínseco que um objeto
celeste aparenta ter na Terra, se este estivesse a uma distância de 10 parsecs. Da mesma
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forma sua velocidade pode ser estimada a partir de parâmetros orbitais. (NEOMAP, 2004;
LCO, 2022)

A distribuição de NEAs conhecidos pode ser obtida de acordo com suas mag-
nitudes absolutas e velocidades características de cada corpo. Através da representação
da magnitude absoluta H como uma função do quadrado da velocidade de impacto do
asteroide com a superfície da Terra, o gráfico abaixo é obtido:

Figura 2 – Distribuição de NEAs. Fonte: (NEOMAP, 2004)

As curvas no gráfico acima são obtidas a partir de H em função de V2 considerando
uma quantidade de energia fixa para o corpo, sendo a curva superior correspondente a
energia de um objeto de H=18 (valor característico para corpos de aproximadamente 1 km
de diâmetro) e V=18,8 km/s, e a curva inferior correspondente a energia de um objeto
de H=22 (valor característico para corpos de aproximadamente 160 m de diâmetro) e
V=18,8 km/s. A velocidade considerada é a média para os objetos conhecidos. Desta
maneira, um corpo pode possuir uma energia equivalente ou maior que a de um corpo de
1 km de diâmetro viajando a 18,8 km/s se estiver localizado acima da curva superior, e
não apenas acima da linha constante para H=18, o que demonstra que a análise baseada
apenas nas dimensões do corpo pode subestimar os riscos reais que um NEA possa oferecer.
(NEOMAP, 2004)

Nesse contexto, diversos dados são coletados em programas de pesquisa e rastre-
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amento de NEOs, sendo a maior parte destes dados referentes a objetos com diâmetros
maiores de 1 km, enquanto uma grande quantidade de objetos menores ainda permanecem
não descobertos e podem vir a passar despercebidos uma vez que exigem equipamentos
mais sensíveis para sua detecção. Mesmo para objetos relativamente menores, com di-
âmetros que variam de 50 m a 200 m, a energia destrutiva liberada em colisões com
estes corpos pode ser equiparada à energia liberada pela maior Bomba de Hidrogênio já
detonada, independentemente se o corpo se desintegra em sua entrada atmosférica ou
conserva-se até atingir o solo e formar uma cratera. (NEOMAP, 2004)

Apesar da probabilidade da ocorrência de um evento cataclísmico ser estatistica-
mente baixa para um curto período na linha do tempo da evolução geológica da Terra, na
qual o ser humano moderno habita o planeta, esta ameaça é existente na medida em que
milhares de objetos celestes estão constantemente viajando no Sistema Solar e a quan-
tidade de corpos conhecidos e catalogados ainda difere da população real de NEOs. Um
episódio de colisão com um destes corpos pode causar devastações significativas, inclu-
sive destruições em massa, e a redução ou mesmo extinção da civilização humana. Nesse
cenário, o desenvolvimento de tecnologias para que medidas protetivas possam ser toma-
das tornou-se um ramo da ciência que engloba a catalogação e rastreamento de corpos
celestes potencialmente perigosos existentes na vizinhança terrestre e no Sistema Solar;
o planejamento e o envio de missões espaciais focadas na aquisição de dados referentes
à dinâmica orbital, posição, velocidade, composição química, e estrutura física de aste-
roides; e a defesa planetária através da destruição completa do objeto em questão, ou da
deflexão do alvo por meio da alteração de sua órbita.

2.3 Estratégias de Deflexão de NEOs

A partir de programas de pesquisa que realizam a detecção, rastreio e caracteri-
zação de NEOs, estratégias podem ser desenvolvidas para defesa planetária e mitigação
das destruições causadas por eventos de colisão entre um corpo potencialmente perigoso
e a Terra. Tais estratégias dependem de diversos fatores como o intervalo de tempo trans-
corrido entre a detecção do objeto e a colisão em si, a energia que o corpo transporta,
sua massa, composição, velocidade e característica da órbita. (National Research Council,
2010)

Eventos de colisão com objetos relativamente pequenos (aproximadamente 100
metros de diâmetro ou menos), de baixa energia e densidade inferior à de corpos que
possuem em sua composição metais pesados como o ferro, podem resultar em explosões
aéreas, ondas de choque, radiação térmica e devastações sobre uma determinada região.
A maneira mais efetiva e barata de preservar vidas e propriedades neste caso é através da
evacuação da área afetada e construção de abrigos. Para eventos cataclísmicos de médio
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e grande porte que liberam quantidades maiores de energia, a estratégia ideal configura
uma alteração no momento angular e na trajetória do corpo de forma que este não alcance
a Terra. (National Research Council, 2010; COLOMBO, 2010)

Dessa forma, as estratégias de mitigação de uma colisão com um PHO podem ser
classificadas a partir de seus mecanismos de atuação:

• Métodos Slow Push/Pull

Os métodos de slow push/pull consistem em uma alteração gradual da órbita por
meio da aplicação de uma força pequena e constante que atua na direção do mo-
vimento do PHO ou de forma contrária a ele, de forma que o corpo sofra uma
mudança de velocidade e consequentemente surja uma pequena aceleração relativa
à sua órbita regular. Com isso, o objeto pode cruzar a órbita terrestre antes ou
depois do momento previsto em condições sem influências externas. (National Re-
search Council, 2010)

As técnicas de slow push e slow pull funcionam de acordo com três tipos de me-
canismos: a utilização da força gravitacional, a aplicação de uma força de contato
e a utilização de recursos naturais para alteração da órbita do objeto. (National
Research Council, 2010)

A utilização da força gravitacional ocorre a partir do posicionamento de uma sonda
que passa a orbitar o objeto, e com isso a atração gravitacional entre os corpos
produz forças opostas responsáveis por gerar uma aceleração resultante sobre o cen-
tro de massa do sistema. Ao contrário desta técnica, a aplicação de uma força de
contato ocorre por meio de contato direto com o corpo, em que um sistema propul-
sivo aplica uma força sobre ele o movimentando fisicamente. Além disso, recursos
naturais como a energia solar e pressão de radiação podem ser utilizados para gerar
alterações orbitais por meio de mudanças na resposta termo-óptica da superfície do
corpo ou pela evaporação do material que o compõe. (National Research Council,
2010; COLOMBO, 2010)

Estes métodos são efetivos em alvos pequenos, com diâmetro de aproximadamente
200 m ou menos, na qual incrementos pequenos de velocidade, em torno de 1 mm/s,
podem ser aplicados. Caso contrário, este método será efetivo somente se houver um
longo período de tempo de advertência, portanto eles são aplicáveis em apenas 1%
dos cenários alarmantes, ou ainda, podem ser utilizados para refinar grandes mu-
danças de órbitas obtidas por meio de outros métodos. (National Research Council,
2010; NASA, 2007)

• Métodos Impulsive

Os métodos caracterizados como impulsive são os de atuação imediata sobre o corpo.
Eles consistem na aplicação instantânea de uma grande quantidade de momento
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e energia sobre o corpo de forma que ele mude de órbita e desvie da Terra, ou
mesmo seja partido em fragmentos, embora esta última opção possa ser arriscada se
houverem riscos dos fragmentos ainda assim atingirem a Terra. (National Research
Council, 2010; COLOMBO, 2010)

As duas opções existentes para que uma grande quantidade de energia seja trans-
ferida para o corpo se dão por meio de explosões nucleares, que consistem em ex-
plosivos nucleares que são detonados na superfície do corpo, acima ou abaixo dela,
ou por meio de impactadores cinéticos, que são veículos espaciais de alta velocidade
(acima de 5 km/s) que colidem com o alvo causando uma variação de momento
linear de forma que o corpo entre em uma nova órbita. (NASA, 2007; National
Research Council, 2010)

Em decorrência da necessidade de uma grande quantidade de energia liberada, os
explosivos nucleares são os que liberam a maior energia e se mostram os mais efeti-
vos, com isso exigem um menor grau de precisão quanto aos dados de caracterização
do objeto, como propriedades físicas e massa, sendo necessário apenas o conheci-
mento de parâmetros orbitais e da massa aproximada. Já os impactadores cinéticos
se mostram a solução que não utiliza energia nuclear mais efetiva e de tecnologia
simplificada, e podem entregar entre 1/10 a 1/100 da energia liberada pelas alterna-
tivas nucleares. Entretanto, os impactadores cinéticos são sensíveis às características
como porosidade, elasticidade e composição do corpo, e portanto exigem uma carac-
terização detalhada das propriedades físicas e químicas do corpo ou uma margem
de performance mais ampla. (NASA, 2007; COLOMBO, 2010)

De acordo com os métodos descritos acima, a escolha ideal a ser implementada
depende intrinsecamente de fatores como o tamanho e propriedades físicas do PHO, o
tempo que se passará entre a detecção do objeto, planejamento, concepção e lançamento
da missão, e o momento do impacto em si, a massa total que poderá ser lançada e a
velocidade que o veículo poderá atingir com o objetivo de alcançar a trajetória ideal para
interceptar o corpo, fatores estes que dependem da capacidade dos veículos lançadores
existentes, da existência de sistemas propulsivos que forneçam propulsão adicional para
maiores velocidades e alterações de trajetórias, e dos parâmetros orbitais do PHO. Além
disso, mais de um método pode ser empregado caso o cenário em questão exija ações mais
eficientes. (National Research Council, 2010)

As figuras a seguir mostram tabelas de comparativos entre os métodos de mitigação
existentes atualmente:
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Dessa maneira, a figura a seguir mostra a aplicabilidade das estratégias de miti-
gação discutidas anteriormente de acordo com os cenários possíveis, em que os principais
parâmetros são o diâmetro do corpo, o tempo de advertência, e a necessidade da missão
ser lançada imediatamente ou de ser planejada e concebida para um lançamento futuro:

Figura 3 – Estratégias de Mitigação. Fonte: (National Research Council, 2010)

É possível observar na figura acima que não há um limite bem definido entre as
regiões do gráfico, caracterizando-se assim imprecisões que devem ser consideradas, já que
outros parâmetros como densidade do NEO, detalhes de sua órbita e probabilidade de
colisão no intervalo de tempo de advertência também são influentes. Consequentemente,
certos cenários que se encontram nas regiões de transição exigem informações e estudos
detalhados para que haja uma delimitação mais precisa sobre os métodos adequados a
serem empregados. Em decorrência da ampla quantidade de incertezas que permeiam
a efetividade de uma missão de mitigação e dificuldade da replicação dos cenários em
laboratórios físicos, programas de pesquisa aplicada voltados para o NEO, e ainda simu-
lações numéricas e experimentos em laboratórios feitos por diversos grupos de pesquisa
podem auxiliam na redução de incertezas, uma vez que nesses casos, a precisão e sucesso
da missão são fundamentais para que a ameaça seja extinguida ou amenizada. (National
Research Council, 2010)



40 Capítulo 2. Contextualização

A partir da discussão apresentada neste capítulo, o escopo desse trabalho será
delimitado ao estudo de missões espaciais para deflexão de NEOs por meio do emprego
de impactadores cinéticos.



41

3 Dinâmica Orbital

3.1 Definição do Problema Envolvendo a Deflexão de NEOs

A solução do problema envolvendo a deflexão de um NEO que esteja em rota de
colisão com a Terra abrange uma modelagem matemática que demonstra o movimento
e dinâmica do corpo e as relações matemáticas que descrevem a deflexão do mesmo. Tal
problema pode ser decomposto em um sistema de equações acopladas que descrevem a
dinâmica do NEO e do veículo que transferirá momento a ele, os estados e parâmetros
envolvidos, e o controle que será aplicado sobre o corpo. Para isso, considera-se um NEO
que tenha sido detectado e identificado por parâmetros orbitais bem definidos, e presume-
se que sua rota adentrará a região denominada Esfera de Conforto ou Sphere of Comfort
(SOC), que é definida como a área delimitada por uma esfera centrada na Terra na qual
nenhum corpo deve cruzar. (HALL; ROSS, 1997)

O problema fundamental pode ser observado na figura a seguir:

Figura 4 – Problema Fundamental. Fonte: (HALL; ROSS, 1997)

Segundo a figura acima, R é definido como o vetor posição do NEO em relação à
Terra, e o vetor de estado x descreve o seu movimento. Para que o NEO seja defletido, é
necessário que sejam satisfeitas condições que garantem que uma alteração de x de modo



42 Capítulo 3. Dinâmica Orbital

que (HALL; ROSS, 1997):

‖𝑅‖ = 𝑅 ≥ 𝑆𝑂𝐶 ∀𝑡

Em qualquer instante de tempo, o módulo do vetor posição deve ser maior ou igual
a SOC, de forma que o NEO não intercepte a Terra. De forma equivalente 𝑅𝑚𝑖𝑛 ≥ 𝑆𝑂𝐶,
ou 𝑅𝑚𝑖𝑛 = min 𝑅 em 𝑡 ≥ 𝑡0, na qual 𝑡0 é o momento de detecção do objeto. Com isso, R
deve satisfazer as condições de continuidade e diferenciabilidade, para que 𝑅𝑚𝑖𝑛 satisfaça
as seguintes condições (HALL; ROSS, 1997):

d𝑅

d𝑡
= 0 𝑒

d2𝑅

d𝑡2 > 0

A dinâmica do NEO pode ser descrito em função dos seguintes parâmetros:

ẋ = f (x, u, t; pa)

Na relação acima, o vetor x descreve a posição, velocidade, orientação e velocidade angular
do NEO, u descreve o controle aplicado sobre o corpo por um veículo que funcionará como
mecanismo de deflexão, o vetor f (·) representa as forças e momentos atuantes sobre o
NEO, e o vetor pa descreve as propriedades do corpo, como composição e massa. (HALL;
ROSS, 1997)

De forma análoga, a dinâmica do veículo válida para um instante de tempo após o
instante do lançamento da missão, pode ser descrita em função de parâmetros semelhantes:

ẏ = g (y, v, t; ps)

O vetor y caracteriza o estado do veículo, v descreve o seu controle, g descreve as forças
e momentos atuantes sobre o veículo, e ps descreve os parâmetros que caracterizam o
veículo, como a massa da payload. (HALL; ROSS, 1997)

Dado que o vetor u é caracterizado como o controle exercido sobre o NEO pelo
veículo, ele depende intrinsecamente dos parâmetros que definem a dinâmica de ambos os
corpos:

𝑢̇ = h (x, y, t; pa, ps, pd)

O termo pd caracteriza os parâmetros de missão e as características e capacidades do
mecanismo de deflexão. Uma vez que os parâmetros que definem h (·) variam de acordo
com as diversas formas em que u pode ser aplicado ao NEO, não há uma modelagem única,
porém análises semelhantes podem ser aplicadas de acordo com a forma de atuação do
mecanismo de deflexão. (HALL; ROSS, 1997)
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Dada a distância entre a Terra e o NEO como 𝑅 (𝑡) = 𝐹 (x (𝑡) , 𝑡), uma estratégia
de deflexão deve ser determinada para que os parâmetros v, ps, pd sejam definidos de
forma que satisfaçam a condição em que a distância mínima que o corpo pode se aproximar
da Terra seja dada por:

min 𝑅 = min 𝐹 (x (𝑡) , 𝑡) ≥ 𝑆𝑂𝐶

Neste cenário, as soluções otimizadas buscam maximizar a menor distância em que o NEO
pode se aproximar da Terra, a fim de que ele seja afastado o máximo possível. (HALL;
ROSS, 1997)

Para a definição da equação de ẋ que descreve a dinâmica do NEO, e de forma
análoga ẏ que descreve a dinâmica do veículo, o problema dos n-corpos deve ser conside-
rado.

3.2 Problema dos N-corpos
O problema dos n-corpos descreve o movimento de um corpo, como um satélite,

sonda, planeta, etc que está sujeito à ação gravitacional em decorrência de interações com
as várias massas existentes no espaço, e à ação de outras forças como arrasto, empuxo e
pressão de radiação solar. Assim, um sistema de n corpos é considerado como um conjunto
de massas 𝑚1, 𝑚2, 𝑚3, ..., 𝑚𝑛, no qual o corpo a ser estudado é definido como o i-ésimo
corpo de massa 𝑚𝑖. (BATE et al., 1971)

A determinação da equação do movimento se dá por meio do vetor resultante da
soma de todas as forças gravitacionais, e de outras forças externas que atuam sobre 𝑚𝑖.
A Lei da Gravitação Universal de Newton é utilizada para a determinação das forças
gravitacionais, porém esta se aplica apenas aos corpos perfeitamente esféricos, assim,
variações e efeitos não previstos que ocorrem por influência do formato dos corpos devem
ser considerados. (BATE et al., 1971)

Tendo um sistema de coordenas apropriado para a descrição do movimento a ser
analisado, cujos eixos cartesianos são dados por X, Y, Z , as posições dos n corpos
r1, r2, r3, ..., rn são definidas de acordo com a figura a seguir:
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Figura 5 – Problema dos N -corpos. Fonte: (BATE et al., 1971)

Pela Lei da Gravitação Universal, a força Fgn exercida sobre o corpo de massa 𝑚𝑖

pelo corpo de massa 𝑚𝑛 é dada por:

Fgn = −𝐺 𝑚𝑖 𝑚𝑛

(𝑟𝑛𝑖)3 ⟨rni⟩ (3.1)

sendo rni = ri − rn a distância entre os corpos.

O vetor resultante Fg pode ser dado como o somatório de todos as forças gravita-
cionais que atuam sobre o i-ésimo corpo (BATE et al., 1971):

Fg = −𝐺 𝑚𝑖

𝑛∑︁
𝑗=1

𝑚𝑗

(𝑟𝑗𝑖)3 ⟨rji⟩ 𝑝𝑎𝑟𝑎 𝑗 ̸= 𝑖 (3.2)

Forças externas que também atuam sobre o corpo, como arrasto, empuxo, pressão
de radiação solar, e perturbações provenientes de formas não esféricas, são representadas
na figura por Fother. Com isso a força total atuante pode ser calculada por (BATE et al.,
1971):

Ftotal = Fg + Fother (3.3)

A partir da equação acima, a força total é dada pela Segunda Lei de Newton:

Ftotal = d
d𝑡

(𝑚𝑖 vi) = 𝑚𝑖
dvi

d𝑡
+ vi

d𝑚𝑖

d𝑡
(3.4)
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A equação acima pode então ser dividida por mi, o que resulta na equação geral
do movimento para o i-ésimo corpo:

r̈i = Ftotal

𝑚𝑖

− ṙi
𝑚̇𝑖

𝑚𝑖

(3.5)

em que r̈i é o vetor aceleração e ṙi o vetor velocidade do corpo relativos ao sistema de
coordenadas (X,Y,Z), e ṁi a taxa de variação da massa do corpo caso este esteja ejetando
uma quantidade de massa ou caso efeitos relativísticos estejam sendo considerados. (BATE
et al., 1971)

Considerando que forças externas e ejeções de massa são nulas, a Terra pode ser
representada como a massa 𝑚1, e um corpo que a orbita como a massa 𝑚2. A diferença
entre o vetor aceleração da Terra referente à interação gravitacional com 𝑚2, e o vetor
aceleração do corpo de massa 𝑚2, referente à sua interação gravitacional com a Terra e
outros corpos, pode ser expresso pela equação (BATE et al., 1971):

r̈12 = −

⎡⎣𝐺 𝑚1

(𝑟12)3 ⟨r12⟩ + 𝐺
𝑛∑︁

𝑗=3

𝑚𝑗

(𝑟𝑗2)3 ⟨rj2⟩

⎤⎦−

⎡⎣− 𝐺 𝑚2

(𝑟21)3 ⟨r21⟩ − 𝐺
𝑛∑︁

𝑗=3

𝑚𝑗

(𝑟𝑗1)3 ⟨rj1⟩

⎤⎦ (3.6)

Uma vez que r12 = − r21, a equação acima pode ser simplificada para:

r̈12 = −𝐺(𝑚1 + 𝑚2)
(𝑟12)3 ⟨r12⟩ −

𝑛∑︁
𝑗=3

𝐺𝑚𝑗

(︃
rj2

(𝑟𝑗2)3 − rj1

(𝑟𝑗1)3

)︃
(3.7)

A equação 3.7 representa a equação geral para o movimento relativo entre dois
corpos sob a influência de perturbações geradas por outros corpos. Levando em conside-
ração o movimento de um corpo de massa 𝑚2 (como um NEO) em torno da Terra de
massa 𝑚1, a equação 3.7 fornece a aceleração relativa do corpo com relação à Terra. O
último termo refere-se às perturbações causadas por outros corpos como a Lua, o Sol e
outros planetas sobre o NEO, em que é possível determinar a magnitude das perturbações
em comparação à força gravitacional entre o corpo e à Terra. (BATE et al., 1971)

3.3 Problema de Dois Corpos
O problema de dois corpos é uma simplificação do Problema de N -corpos para des-

crever o movimento de dois objetos celestes a partir de algumas simplificações da equação
geral do movimento relativo. Considera-se que os corpos são esfericamente simétricos,
podendo ser modelados como uma massa concentrada, e perturbações externas podem
ser desprezíveis, sendo válidas apenas as forças geradas pela interação gravitacional entre
esses corpos. (FORTESCUE; SWINERD; STARK, 2011; BATE et al., 1971)
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Figura 6 – Problema de Dois Corpos. Fonte: (FORTESCUE; SWINERD; STARK, 2011)

A equação do movimento sem perturbações que descreve a ação gravitacional
de um corpo de massa 𝑚1 sobre um corpo 𝑚2 é dada por (FORTESCUE; SWINERD;
STARK, 2011):

r̈ = −𝐺(𝑚1 + 𝑚2)
‖r‖3 r (3.8)

Nos casos em que 𝑚1 > > 𝑚2 , sendo 𝑚1 muito maior, a equação acima pode ser
simplificada desconsiderando 𝑚2, e considerando M como a massa do corpo maior. Este
caso corresponde ao problema restrito de dois corpos, e é definido pela equação:

r̈ = − 𝐺M
‖r‖3 r (3.9)

em que o termo GM define o parâmetro gravitacional 𝜇. (FORTESCUE; SWINERD;
STARK, 2011)

A solução desta equação demonstra a Primeira Lei de Kepler, e é definida como
a equação das seções cônicas, que descreve o movimento de corpos celestes sob uma ação
gravitacional central. Ela é demonstrada por:

𝑟(𝜃) = ℎ2/𝜇

1 + 𝑒 cos 𝜃
(3.10)

em que h representa o momento angular específico de um corpo em órbita. (FORTESCUE;
SWINERD; STARK, 2011)

A excentricidade 𝑒 determina em que tipo de órbita o corpo menor orbita o corpo
de maior influência gravitacional. Quando assume valores entre 0 < 𝑒 < 1, a órbita é
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elíptica, ou circular para o caso específico em que 𝑒 = 0. Para 𝑒 = 1 a órbita se torna
parabólica, ou hiperbólica para 𝑒 > 1. A imagem abaixo demonstra as seções cônicas
obtidas por meio da equação 3.10:

Figura 7 – Seções Cônicas. Fonte: (FORTESCUE; SWINERD; STARK, 2011)

Considerando que a maioria dos NEOs seguem órbitas elípticas tendo o Sol como
corpo central, são necessários parâmetros orbitais para definir o formato da elipse, e,
consequentemente, gerar a trajetória do corpo em torno do Sol. A figura a seguir mostra
estes parâmetros:
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Figura 8 – Parâmetros Orbitais de Órbitas Elípticas. Fonte: (FORTESCUE; SWINERD;
STARK, 2011)

Os parâmetros orbitais representados acima podem ser calculados através das
equações apresentadas a seguir, onde (BATE et al., 1971):

• 𝑎 é o semi-eixo maior da órbita.

• 𝑒 é a excentricidade orbital.

• 𝑟𝑝 o raio do periapsis, ponto mais próximo do corpo central.

• 𝑟𝑎 o raio do apoapsis, ponto mais distante do corpo central.

As equações são:

𝑝 = 𝑎(1 − 𝑒2) (3.11)

𝑟𝑝 = 𝑎(1 − 𝑒) (3.12)

𝑟𝑎 = 𝑎(1 + 𝑒) (3.13)
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3.4 Cenário de Interceptação e Impacto com NEOs
A interceptação e deflexão de um NEO depende de alguns fatores e particularidades

que caracterizam o cenário em questão, como o tempo que decorrerá entre a detecção do
objeto e a colisão com a Terra, a urgência de uma missão para mitigação e deflexão do
corpo, as ações que podem ser tomadas caso hajam vários períodos orbitais remanescentes
até o momento de impacto, e se o corpo está a menos de uma unidade astronômica
(UA), ou se a colisão pode ser evitada por uma pequena variação de velocidade, mais
efetivamente no periélio. (HALL; ROSS, 1997; SOLEM, 1993)

3.4.1 Cenário de Colisão Inelástica

Assumindo uma transferência de momento linear em decorrência de uma colisão
inelástica entre um veículo impactador massivo e o NEO, de forma que o NEO não se
fragmente e todo o momento linear do impactador seja transferido ao sistema formado
pelo corpo e veículo, uma abordagem pode ser construída para se definir a velocidade de
impulso Δ𝑉 que será aplicada sobre o corpo, para que uma correção instantânea em sua
velocidade heliocêntrica possa ser feita de forma que sua trajetória seja alterada.(HALL;
ROSS, 1997; IVASHKIN; SMIRNOV, 1995)

Considera-se que a órbita da Terra seja circular de raio 𝑟𝑇 , e o NEO esteja em uma
órbita no plano da eclíptica, em que a distância do afélio é 𝑟𝑎,𝑛𝑒𝑜 e a distância do periélio
𝑟𝑝,𝑛𝑒𝑜. De forma análoga, considera-se que o veículo tem como trajetória meia órbita de
transferência de Hohmann elíptica, na qual o seu afélio está localizado na Terra e seu
periélio coincide com o periélio da órbita do NEO e o ponto de colisão entre eles. Com
isso, a distância do afélio é 𝑟𝑎,𝑉 e a distância do periélio 𝑟𝑝,𝑉 . (IVASHKIN; SMIRNOV,
1995)

O cenário descrito acima pode ser observado na figura abaixo:



50 Capítulo 3. Dinâmica Orbital

Figura 9 – Órbitas da Terra, NEO e veículo impactador. Fonte: (IVASHKIN; SMIRNOV,
1995)

Na figura acima, 1 representa a órbita terrestre; 2 a órbita do NEO; 3 a trajetória
do veículo impactador da Terra até o encontro com o NEO; 4 o ponto de intersecção entre
as órbitas do NEO e da Terra; 5 o ponto de onde parte o veículo da Terra e 6 o ponto de
colisão entre o NEO e o veículo. (IVASHKIN; SMIRNOV, 1995)

Considerando um veículo orbitando a Terra como um satélite artificial, em uma
órbita circular de raio 𝑟0 , com massa equivalente a 𝑚0, e impulso específico equivalente
a 𝑐1, a massa do veículo no momento da colisão com o NEO pode ser calculada por
(IVASHKIN; SMIRNOV, 1995):

𝑚𝑉 = 𝑚0 exp
(︃

−Δ𝑣1

𝑐1

)︃
(3.14)

Na equação acima, Δ𝑣1 é a variação de velocidade aplicada ao veículo a partir de
sua órbita circular geocêntrica de raio 𝑟0, e pode ser calculada pela equação:

Δ𝑣1 =
(︂

𝑣2
∞ + 2𝜇𝑇

𝑟0

)︂1/2
−
(︂

𝜇𝑇

𝑟0

)︂1/2
(3.15)

em que o termo 𝜇𝑇 corresponde ao parâmetro gravitacional da Terra e 𝑣∞ à velocidade
geocêntrica do veículo no infinito. (IVASHKIN; SMIRNOV, 1995)

A velocidade 𝑣∞ pode ser calculada pela diferença entre a velocidade geocêntrica
do veículo no afélio 𝑣𝑎,𝑉 e a velocidade da Terra 𝑣𝑇 no momento em que o veículo parte
de sua órbita geocêntrica, como mostrado na equação abaixo (IVASHKIN; SMIRNOV,
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1995):
𝑣∞ = |𝑣𝑎,𝑉 − 𝑣𝑇 | (3.16)

Assumindo uma colisão inelástica entre o veículo e o NEO, o incremento de velo-
cidade aplicado ao corpo pode ser calculado por:

𝛿𝑣𝑛𝑒𝑜 = 𝑚𝑉

𝑚𝑛𝑒𝑜 + 𝑚𝑉

(𝑣𝑉 − 𝑣𝑛𝑒𝑜) (3.17)

em que as velocidades 𝑣𝑣 e 𝑣𝑛𝑒𝑜 são as velocidades heliocêntricas no periélio de ambas as
órbitas, do veículo e do NEO, no momento que antecede colisão. (IVASHKIN; SMIRNOV,
1995)

O incremento de velocidade 𝛿𝑣𝑛𝑒𝑜 decorrente do impacto é responsável por causar
um pequeno deslocamento no NEO de n revoluções orbitais em seu periélio. Este desloca-
mento ocorre transversalmente à órbita podendo ser considerado aproximadamente igual
à distância mínima entre o NEO e a Terra no momento da colisão, e obtido por:

𝛿𝑙 = 𝑣𝑝,𝑛𝑒𝑜 𝑛 𝛿𝑇 (3.18)

em que 𝛿𝑇 é a pequena variação no período orbital do corpo causada pelo incremento de
velocidade. (IVASHKIN; SMIRNOV, 1995)

O período orbital T pode ser calculado pela Terceira Lei de Kepler:

𝑇 = 2𝜋

(︃
𝑎3

𝜇

)︃1/2

(3.19)

em que 𝑎 é o semieixo maior da órbita e 𝜇 o parâmetro gravitacional do Sol.

A partir da equação de energia orbital específica para o problema de dois corpos,
tem-se que:

𝑣2
𝑝 − 2𝜇

𝑟𝑝

= −𝜇

𝑎
= − 2𝜇

𝑟𝑝 + 𝑟𝑎

(3.20)

em que 𝑣𝑝 é a velocidade no periélio, 𝑟𝑝 a distância do periélio e 𝑟𝑎 a distância do afélio.

Analogamente, a partir das equações 3.19 e 3.20, as variações 𝛿𝑇 e 𝛿𝑣𝑝 são obtidas
respectivamente:

𝛿𝑇 = 3𝑇

2𝑎
𝛿𝑎 (3.21)

2 𝑣𝑝 𝛿𝑣𝑝 = 𝜇

𝑎2 𝛿𝑎 (3.22)

Substituindo as equações 3.21 e 3.22 na 3.18, tem-se que:

𝛿𝑙 = 3 𝑛 𝑇 𝑣2
𝑝,𝑛𝑒𝑜

𝑎

𝜇
𝛿𝑣𝑝,𝑛𝑒𝑜 = 3 𝑛 𝑇

𝑟𝑎,𝑛𝑒𝑜

𝑟𝑝,𝑛𝑒𝑜

𝛿𝑣𝑝,𝑛𝑒𝑜 (3.23)
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em que 𝛿𝑣𝑝,𝑛𝑒𝑜 é obtido da equação 3.17. (IVASHKIN; SMIRNOV, 1995)

Da equação 3.20, são obtidas as relações para as velocidades no periélio e afélio
respectivamente:

𝑣𝑝 =
(︃

2𝜇

𝑟𝑝

)︃1/2 (︃
𝑟𝑎

𝑟𝑝 + 𝑟𝑎

)︃1/2

(3.24)

𝑣𝑎 =
(︂2𝜇

𝑟𝑎

)︂1/2 (︃ 𝑟𝑝

𝑟𝑝 + 𝑟𝑎

)︃1/2

(3.25)

Com isso, a velocidade do veículo na saída de sua órbita terrestre 𝑣∞ e a velocidade
da colisão entre o veículo e o NEO podem ser determinadas por (IVASHKIN; SMIRNOV,
1995):

𝑣∞ =
(︂

𝜇

𝑟𝑇

)︂1/2
⎡⎣(︃ 2 𝑟𝑝,𝑉

𝑟𝑝,𝑉 + 𝑟𝑎,𝑉

)︃1/2

− 1
⎤⎦ (3.26)

|𝑣𝑉 − 𝑣𝑛𝑒𝑜| =
(︃

2𝜇

𝑟𝑝,𝑛𝑒𝑜

)︃1/2
⎡⎣(︃ 𝑟𝑝,𝑛𝑒𝑜

𝑟𝑝,𝑛𝑒𝑜 + 𝑟𝑎,𝑛𝑒𝑜

)︃1/2

−
(︃

𝑟𝑎,𝑉

𝑟𝑝,𝑉 + 𝑟𝑎,𝑉

)︃1/2
⎤⎦ (3.27)

3.4.2 Cenário de Colisão com Ejeção de Massa

Considerando um cenário de interceptação de um corpo, seja ele asteroide ou
cometa, que esteja viajando em direção à Terra a uma velocidade 𝑣, em que o veículo
interceptador viaja a uma velocidade 𝑉 . O corpo possui uma massa 𝑀𝑎 e o interceptador
uma massa final 𝑀𝑓 , já que ele perdeu massa do combustível expelido, assim 𝑀𝑐 ≫ 𝑀𝑓 . O
interceptador deve ser capaz de explodir uma região da superfície de forma que haja ejeção
de massa. A massa ejetada é consideravelmente mais massiva que o interceptador, de modo
que 𝑀𝑐 ≫ 𝑀𝑒 ≫ 𝑀𝑓 . A figura abaixo ilustra o cenário de interceptação (SOLEM, 1993):

A velocidade do veículo interceptador relativa à Terra, quando este estiver estaci-
onado em órbita pode ser dada pela equação de foguete de Tsiolkovski:

𝑉 = 𝑔𝐼𝑠𝑝 ln 𝑀𝑖

𝑀𝑓

(3.28)

O tempo necessário para atingir essa velocidade é muito pequeno comparado ao
tempo total de voo ao longo da missão, e o tempo total do momento do lançamento até
a interceptação do corpo é dado por (SOLEM, 1993):

Δ𝑡 = 𝑅𝑙

𝑣 + 𝑉
(3.29)
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Figura 10 – Cenário de Interceptação. Fonte: (SOLEM, 1993)

A distância em que o corpo será interceptado pode ser calculada por (SOLEM,
1993):

𝑅𝑖 = 𝑅𝑙

(︂
1 − 𝑣

𝑣 + 𝑉

)︂
(3.30)

Se o componente da velocidade aplicada sobre o corpo pelo veículo interceptador
ortogonal é transversal à direção do impacto, e denotado por 𝑣⊥, o corpo se deslocará uma
distância que pode ser determinada a partir de uma aproximação linear do movimento
Kepleriano (SOLEM, 1993):

𝜖 = 𝑅𝑙
𝑣⊥

𝑣

(︂
𝑉

𝑣 + 𝑉

)︂
(3.31)

O componente transversal da velocidade 𝑣⊥ pode ser calculado a partir da energia
cinética do interceptador para criar uma cratera na superfície do alvo durante a colisão. O
momento da massa ejetada seria contrabalanceado pelo momento transversal transferido
pelo veículo. A massa ejetada da cratera formada pela explosão é dada por:

𝑀𝑒 = 𝛼2𝐸𝛽 (3.32)

em que os parâmetros 𝛼 e 𝛽 dependem de diversos fatores como local do impacto e da
explosão, densidade do corpo, composição do solo, e gravidade, entretanto, a maioria das
situações apresentam um valor para 𝛽 de aproximadamente 0,9. (SOLEM, 1993)

A energia cinética no momento da colisão entre o interceptador e o corpo é dada
por (SOLEM, 1993):
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𝐸 = 1
2𝑀𝑓 (𝑉 + 𝑣)2 (3.33)

Uma fração da energia cinética transportada pelo interceptador é convertida em
energia cinética da ejeção de massa. Se esta fração for equivalente a 1/2 𝛿2, então:

𝛿 =
√︃

2 𝑒𝑛𝑒𝑟𝑔𝑖𝑎 𝑐𝑖𝑛é𝑡𝑖𝑐𝑎 𝑑𝑎 𝑚𝑎𝑠𝑠𝑎 𝑒𝑗𝑒𝑡𝑎𝑑𝑎

𝑒𝑛𝑒𝑟𝑔𝑖𝑎 𝑐𝑖𝑛é𝑡𝑖𝑐𝑎 𝑑𝑜 𝑖𝑛𝑡𝑒𝑟𝑐𝑒𝑝𝑡𝑎𝑑𝑜𝑟
(3.34)

em que 𝛿 pode ser considerado o parâmetro de fração de energia. (SOLEM, 1993)

Assim, a velocidade transversal aplicada sobre o corpo pode ser calculada da se-
guinte maneira (SOLEM, 1993):

𝑣⊥ = 𝛿

√
𝑀𝑒𝐸

𝑀𝑎

= 𝛿

𝑀𝑎

√︃
𝑀𝑒𝑀𝑓 (𝑉 + 𝑣)2

2 (3.35)

𝑣⊥ = 𝛼𝛿

𝑀𝑎

[︃
𝑀𝑓 (𝑉 + 𝑣)2

2

]︃𝛽+1
2

(3.36)

Combinando as equações 3.31, 3.32 e 3.36, a deflexão 𝜖 pode então ser calculada
por (SOLEM, 1993):

𝜖 = 𝛼𝛿𝑅𝑙
𝑉 (𝑉 + 𝑣)𝛽

𝑀𝑎𝑣

(︂
𝑀𝑓

2

)︂𝛽+1
2

(3.37)

De acordo com a equação acima, se 𝑉 ≪ 𝑣 a deflexão será proporcional à veloci-
dade de interceptação 𝑉 , que por sua vez é proporcional ao impulso específico 𝐼𝑠𝑝, e se
𝑉 ≫ 𝑣, a deflexão será proporcional à 𝑉 𝛽+1 ∼ 𝑉 2. (SOLEM, 1993)

3.5 Modelagem Matemática do Problema de Deflexão de NEOs
Considerando um NEO cujos parâmetros orbitais são bem definidos, a menor dis-

tância entre sua órbita e a órbita da Terra é definida como a Distância Mínima de Inter-
seção Orbital ou Minimum Orbit Intersection Distance (MOID), representada por Δr, e
utilizada como indicador de potenciais colisões. Devido às pertubações gravitacionais, a
MOID pode sofrer variações ao longo do tempo. Em um cenário em que ‖Δr‖ é conside-
ravelmente pequeno, um encontro entre ambos os corpos é provável se eles estiverem em
fase. (COLOMBO, 2010)

O objetivo do problema de deflexão de NEOs é a aplicação de uma força impulsiva
sobre o corpo em um determinado instante de tempo 𝑡𝑑 de tal forma que o seu desvio
seja maximizado no ponto em que ocorre a MOID. A força impulsiva atua como uma
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perturbação quase instantânea, alterando a órbita nominal do corpo para uma nova órbita
aproximada. A figura abaixo mostra esse cenário (COLOMBO, 2010):

Figura 11 – Deflexão do NEO. Fonte: (COLOMBO, 2010)

Os parâmetros orbitais da órbita do NEO podem ser definidos por: a o semieixo
maior da órbita, e a excentricidade, i a inclinação, Ω a longitude do nó ascendente, 𝜔 o
argumento do periastro, M a anomalia média, 𝜃𝑀𝑂𝐼𝐷 a anomalia verdadeira no ponto da
MOID ao longo da órbita na ausência de perturbações, e 𝜃*

𝑀𝑂𝐼𝐷 = 𝜃𝑀𝑂𝐼𝐷 +𝜔 o argumento
da latitude. A variação na posição do NEO após a deflexão com relação à sua posição
original na ausência de perturbações pode ser dada pelas equações a seguir (COLOMBO,
2010):

𝛿𝑠𝑟 ≈ 𝑟𝑀𝑂𝐼𝐷

𝑎
𝛿𝑎 + 𝑎 𝑒 sin 𝜃𝑀𝑂𝐼𝐷

𝜂
𝛿𝑀 − a cos 𝜃𝑀𝑂𝐼𝐷 𝛿e (3.38)

𝛿𝑠𝜃 ≈𝑟𝑀𝑂𝐼𝐷

𝜂3 (1 + 𝑒 cos 𝜃𝑀𝑂𝐼𝐷)2 𝛿𝑀 + 𝑟𝑀𝑂𝐼𝐷𝛿𝜔

+ 𝑟𝑀𝑂𝐼𝐷 sin 𝜃𝑀𝑂𝐼𝐷

𝜂2 (2 + 𝑒 cos 𝜃𝑀𝑂𝐼𝐷) 𝛿𝑒 + 𝑟𝑀𝑂𝐼𝐷 cos 𝑖𝛿Ω
(3.39)

𝛿𝑠ℎ ≈ 𝑟𝑀𝑂𝐼𝐷 (sin 𝜃*
𝑀𝑂𝐼𝐷 𝛿𝑖 − cos 𝜃*

𝑀𝑂𝐼𝐷 sin 𝑖𝛿Ω) (3.40)

em que os termos 𝛿𝑠𝑟, 𝛿𝑠𝜃, 𝛿𝑠ℎ são os deslocamentos nas direções radial, transversal e
perpendicular ao plano da órbita, e 𝜂 =

√
1 − 𝑒2. (COLOMBO, 2010)

De acordo com as equações acima, a variação da posição relativa é dada por 𝛿r =
[𝛿𝑠𝑟 𝛿𝑠𝜃 𝛿𝑠ℎ]𝑇 . Uma linearização pode ser feita considerando que 𝛿𝑟 = ‖𝛿r‖ é muito
pequeno em relação ao raio da órbita principal 𝑟𝑀𝑂𝐼𝐷, com isso 𝛿𝑟 ≪ 𝑟𝑀𝑂𝐼𝐷. Pelo termo√

1 − 𝑒2, as equações acima são restritas às elipses elípticas, em que 𝑒 < 1. (COLOMBO,
2010)
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Considerando uma variação instantânea no vetor velocidade 𝛿v do NEO, em que
seus componentes são dados por 𝛿v = [𝛿𝑣𝑡 𝛿𝑣𝑛 𝛿𝑣ℎ]𝑇 nas direções tangente e normal
ao vetor velocidade no plano da órbita osculante e perpendicular a ele, as variações dos
parâmetros a, e, i, Ω e 𝜔 podem ser calculadas pelas equações planetárias de Gauss:

𝛿𝑎 = 2𝑎2𝑣𝑑

𝜇𝑆𝑜𝑙

𝛿𝑣𝑡 (3.41)

𝛿𝑒 = 1
𝑣𝑑

[︂
2 (𝑒 + cos 𝜃𝑑) 𝛿𝑣𝑡 − 𝑟𝑑

𝑎
sin 𝜃𝑑 𝛿𝑣𝑛

]︂
(3.42)

𝛿𝑖 = 𝑟𝑑 cos 𝜃*
𝑑

ℎ
𝛿𝑣ℎ (3.43)

𝛿Ω = 𝑟𝑑 sin 𝜃*
𝑑

ℎ sin 𝑖
𝛿𝑣ℎ (3.44)

𝛿𝜔 = 1
𝑒𝑣𝑑

[︂
2 sin 𝜃𝑑 𝛿𝑣𝑡 +

(︂
2𝑒 + 𝑟𝑑

𝑎
cos 𝜃𝑑

)︂
𝛿𝑣𝑛

]︂
− 𝑟𝑑 sin 𝜃*

𝑑 cos 𝑖

ℎ sin 𝑖
𝛿𝑣ℎ (3.45)

𝛿𝑀𝑡𝑑
= − 𝑏

𝑒𝑎𝑣𝑑

[︃
2
(︃

1 + 𝑒2𝑟𝑑

𝑝

)︃
sin 𝜃𝑑 𝛿𝑣𝑡 + 𝑟𝑑

𝑎
cos 𝜃𝑑 𝛿𝑣𝑛

]︃
(3.46)

em que 𝑟𝑑 é o raio e 𝑣𝑑 é a velocidade no ponto de intercepção do NEO em que a manobra
de deflexão ocorre, h o momento angular , p o semilatus rectum, b o semieixo menor, 𝜇𝑆𝑜𝑙

o parâmetro gravitacional do Sol. (COLOMBO, 2010)

As equações 3.41 a 3.46 listadas acima são restritas às elipses elípticas, em que
𝑒 < 1 por conta do termo

√
1 − 𝑒2, e são válidas para casos em que que a inclinação i e

excentricidade e são diferentes de zero, uma vez que os casos em que 𝑖 = 0 e 𝑒 = 0 apresen-
tam singularidades nas equações que descrevem as variações de Ω, 𝜔 e M. (COLOMBO,
2010)

O termo 𝛿𝑀𝑡𝑑
refere-se à variação da anomalia média M considerando uma va-

riação instantânea na órbita em um instante 𝑡𝑑. No ponto correspondente à MOID, a
variação instantânea da anomalia média ocorre devido à mudança no semieixo maior que
provoca uma variação no movimento médio (mean motion) n, podendo ser calculada por:

𝛿𝑀𝑛 = 𝛿𝑛 (𝑡𝑀𝑂𝐼𝐷 − 𝑡𝑑) = 𝛿𝑛 Δ𝑡 (3.47)

em que 𝑡𝑀𝑂𝐼𝐷 corresponde ao instante em que ocorre a MOID ao longo da órbita do NEO,
e Δ𝑡 o tempo que decorre do ponto de deflexão ao 𝑡𝑀𝑂𝐼𝐷. (COLOMBO, 2010)

O termo 𝛿𝑛 pode ser calculado por (COLOMBO, 2010):
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𝛿𝑛 =
√︃

𝜇𝑆𝑜𝑙

(𝑎 + 𝛿𝑎)3 −
√︂

𝜇𝑆𝑜𝑙

𝑎3 (3.48)

Com isso, a variação na anomalia média M total entre a órbita original e a nova
órbita após a perturbação pode ser calculada por:

𝛿𝑀 = − 𝑏

𝑒𝑎𝑣𝑑

[︃
2
(︃

1 + 𝑒2𝑟𝑑

𝑝

)︃
sin 𝜃𝑑 𝛿𝑣𝑡 + 𝑟𝑑

𝑎
cos 𝜃𝑑 𝛿𝑣𝑛

]︃
+ 𝛿𝑛 Δ𝑡 (3.49)

Pode-se observar nas equações demonstradas nesta seção a relação entre a variação
nos parâmetros geométricos da órbita de um NEO e os componentes da ação perturbadora,
com isso, elas permitem a determinação de qualquer alteração na órbita de um NEO
causada por uma força impulsiva qualquer, e consequentemente, qualquer desvio que o
corpo venha sofrer. (COLOMBO, 2010)
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4 Double Asteroid Redirection Test

4.1 Concepção da Missão
No contexto dos cenários discutidos até o momento, a missão DART, Double As-

teroid Redirection Test ou Teste de Redirecionamento de Asteroide Duplo, realizada pela
National Aeronautics and Space Administration ou NASA, foi a primeira missão de teste
em escala real de defesa planetária, lançada em 24 de novembro de 2021, com o objetivo
de demonstrar a tecnologia de deflexão de asteroides por meio do método de impacto
cinético, comprovando que uma sonda espacial, ou um impactador cinético, pode navegar
e colidir intencionalmente com um asteroide. A sonda DART foi projetada para viajar
até o sistema binário de asteroides Didymos-Dimorphos, que não está em rota de colisão
com a Terra, mas é classificado como NEO. O objetivo principal da missão foi atingir o
asteroide menor Dimorphos, que orbita o asteroide maior Didymos, a uma velocidade de
aproximadamente 6,15 km/s. (NASA, 2022a)

A missão DART fez parte de uma colaboração internacional denominada Asteroid
Impact and Deflection Assessment (AIDA) entre as agências espaciais NASA e ESA, Eu-
ropean Space Agency. A DART atuou em conjunto com a missão Hera, que consistia em
um programa espacial da ESA cujo objetivo foi monitorar e realizar pesquisas sobre o
sistema binário de Didymos-Dimorphos após o impacto com a sonda DART, com foco em
analisar a cratera formada pela colisão e determinação precisa da massa de Dimorphos.
Ambas missões foram projetadas para atuarem de forma independente, embora sejam
complementares, de modo que a missão Hera foi capaz de detalhar e aprofundar o co-
nhecimento em defesa planetária obtido no teste de deflexão de asteroide realizado pela
DART. (Johns Hopkins University Applied Physics Laboratory, 2025)

As figuras abaixo mostram a concepção da missão DART e o cenário idealizado
de colisão entre a sonda e o asteroide Dimorphos:
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Figura 12 – Missão DART. Fonte: NASA/Johns Hopkins APL.

Figura 13 – Trajetória de impacto da sonda DART. Fonte: NASA/Johns Hopkins APL.
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Figura 14 – DART em rota de colisão. Fonte: NASA/Johns Hopkins APL.

O veículo impactador cinético da missão DART é ilustrado nas figuras a seguir:

Figura 15 – Sonda DART. Fonte: NASA/Johns Hopkins APL.
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4.2 Efeitos Pós-Impacto
O asteroide Dimorphos, de aproximadamente 160 m de diâmetro, orbitava o aste-

roide maior Didymos, de aproximadamente 780 m de diâmetro, a uma velocidade de 17
cm/s, a uma distância de aproximadamente 1,2 km, na época que antecedia a colisão com
a sonda DART, ocorrida em 26 de Setembro de 2022. A deflexão que Dimorphos sofreu
em decorrência do impacto com a sonda pôde ser observada com a mudança de sua órbita
em torno do asteroide maior. O período orbital de Dimorphos ao redor de Didymos no
pré-impacto era de aproximadamente 11 horas e 55 minutos, e após a colisão, observa-
ções astronômicas por pesquisadores em telescópios na Terra concluíram que Dimorphos
teve sua órbita alterada em 32 minutos, com margem de erro de 2 minutos. Com isso,
o período orbital pós-impacto foi encurtado para 11 horas e 23 minutos. (NASA, 2022a;
NASA, 2022b)

A imagem a seguir mostra os registros fotográficos da colisão entre DART e Di-
morphos:

Figura 16 – Cenário da colisão entre DART e Dimorphos. Fonte: (NASA, 2023)

A função da sonda espacial DART foi atingir Dimorphos como um projétil em
alta velocidade. Para garantir que a colisão ocorresse no ponto mais próximo à Terra, a
DART foi inserida em uma órbita heliocêntrica semelhante à órbita da Terra, inclinada
em 3,8º em relação a eclíptica, para coincidir com a inclinação da órbita de Didymos.
A transferência de momento entre a DART e o asteroide foi dada pelo impulso gerado
pelo impacto, e reforçada pela ejeção de massa proveniente da superfície do corpo, que
funcionou como uma contribuição extra, e pode ser caracterizada dentro do sistema como
um parâmetro de acréscimo de momento. Este parâmetro está sujeito as condições da
colisão e das propriedades do asteroide. (MAKADIA et al., 2022; BELLEROSE, 2023)

Alguns parâmetros da missão podem ser observados na tabela abaixo:
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Parâmetro Valor

Hora do Impacto 26-09-2022 23:14:24.183 UTC
Velocidade de Impacto 6,144 km/s
Ângulo Total de Impacto 166,113°
Ângulo de Impacto Fora do Plano -9,673°
Ângulo de Impacto no Plano 10,000°
Ângulo de Fase Solar na Aproximação 59,524°
Raio efetivo da sonda DART 0,5 m
Massa da sonda DART 536 kg
Densidade efetiva da sonda DART 1023,69 kg/m3
Coesão do solo de Dimorphos 100 Pa
Porosidade de Dimorphos 35%
Densidade aparente de Dimorphos 2202,77 kg/m3

Tabela 4 – Parâmetros da missão DART. Fonte: (MAKADIA et al., 2022; BELLEROSE,
2023)

Os dados esperados pela NASA antes da colisão, para garantir o sucesso da missão,
eram de uma mudança orbital em torno de 73 segundos no mínimo. O resultado obtido
na missão real ultrapassou em mais de 25 minutos os valores esperados. Com isso, pode-se
concluir que a missão DART foi bem-sucedida em demonstrar o primeiro teste de defesa
planetária e a tecnologia dos impactadores cinéticos. (NASA, 2022b; BELLEROSE, 2023)
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5 Simulações Systems Tool Kit (STK)

5.1 Systems Tool Kit (STK)
A Ansys Inc. é uma empresa líder no desenvolvimento de softwares de simulação

para engenharia sediada no estado da Pensilvânia, Estados Unidos. Sua subsidiária de se-
gurança nacional, Ansys Government Initiatives (AGI), possui em seu portfólio o software
de missão digital e análise de sistemas Ansys Systems Tool Kit® (STK®), que fornece um
ambiente de modelagem baseado em física e simulação de sistemas complexos no contexto
de missões realistas. (Analytical Graphics, Inc., 2024)

O STK permite a modelagem de sistemas dentro de uma simulação tridimensional
realista e dinâmica no tempo, pela qual é possível obter uma compreensão do comporta-
mento e desempenho da missão. Sendo assim, foi o software escolhido para a simular a
missão DART. A versão utilizada para este trabalho foi a STK® v11.2.0.

Figura 17 – STK® v11.2.0. Fonte: AGI

5.2 Estrutura da Simulação
A simulação da missão DART no STK foi realizada em duas etapas: a primeira,

denominada Launch, corresponde ao estágio de lançamento do foguete que transportou
a sonda DART até sua inserção em órbita heliocêntrica; a segunda, denominada Cruise,
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refere-se à trajetória executada pela sonda desde sua entrada em órbita até sua chegada
no sistema binário de Didymos para colisão com Dimorphos.

Algumas considerações foram utilizadas para simplificação, visando uma melhor
adequação às limitações técnicas de software e hardware do computador utilizado, uma
vez que trabalhar com o volume de dados gerados na missão real exigiria uma maior
capacidade computacional. São elas:

• A etapa Launch corresponde ao lançamento desde o liftoff até a separação entre
sonda e foguete, e aos primeiros 30 dias de missão que caracterizaram a fase de
commissioning.

• Apenas o asteroide Didymos foi considerado na etapa Cruise, sendo que Dimorphos
orbita Didymos a uma curta distância, e o objetivo principal foi gerar a trajetória
da DART até o sistema binário em consideração.

• A missão simulada é uma versão simplificada da missão real, com menos estágios e
manobras orbitais.

5.2.1 Efemérides e Dados Iniciais

Para que a simulação fosse baseada nos dados reais da missão, foram utilizadas
as efemérides da sonda DART e do sistema binário Didymos-Dimorphos, geradas pelo
sistema Horizons System desenvolvido pelo Jet Propulsion Laboratory (JPL) da NASA,
com a finalidade de fornecer dados precisos referentes aos corpos celestes do Sistema Solar.

Considerando que o Horizons System utiliza o sistema de tempo TDB (Barycentric
Dynamical Time) e o STK utiliza o sistema UTC (Coordinated Universal Time), foi
necessária a conversão entre esses referenciais. Para isso, utilizou-se um código em Python
(disponível nos apêndices) com a biblioteca Astropy para cálculos astronômicos.

De acordo com o sistema Horizons, o instante de início da missão ocorreu em 2021-
11-24 06:21:02 UTC, com o lançamento de um foguete SpaceX Falcon 9 transportando
a sonda DART, a partir da Base da Força Espacial de Vandenberg, na Califórnia. O
primeiro registro da efeméride da DART ocorreu no instante imediatamente anterior à
separação entre a sonda e o segundo estágio do foguete, em 2021-11-24 07:17:53.000
TDB. (NASA; JPL, 2024)

Dessa forma, foram utilizadas duas efemérides para a DART: a primeira gerada a
partir do instante imediatamente após a separação, e a segunda gerada algumas horas após
a entrada em órbita. Para os asteroides, considerou-se o sistema binário 65803 Didymos
(1996 GT), com início do registro no dia anterior ao lançamento da missão.
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Para o registro final das efemérides foi considerado o instante do impacto entre a
DART e o asteroide Dimorphos, ocorrido em 2022-09-26 23:14:24.183 UTC ou 2022-
09-26 23:15:33.365 TDB. (NASA; JPL, 2024)

As configurações utilizadas na geração das efemérides estão apresentadas nas ima-
gens a seguir:

Figura 18 – Configurações para DART às 07:17 TDB. Fonte: (NASA; JPL, 2024)

Figura 19 – Configurações para DART às 00:00 TDB. Fonte: (NASA; JPL, 2024)
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Figura 20 – Configurações para 65803 Didymos. Fonte: (NASA; JPL, 2024)

Para a opção Table Settings, foram utilizadas as seguintes configurações com o
objetivo de gerar um vetor de estado de posição e velocidade para ambos os corpos
analisados:

Figura 21 – Configurações Table Settings. Fonte: (NASA; JPL, 2024)

As efemérides geradas estão disponíveis nos anexos ao final deste trabalho.
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5.2.2 Launch

A simulação da primeira fase da missão seguiu os passos apresentados a seguir:

1. Cenário

Primeiramente, foi criado um cenário com o instante inicial (Start) definido como a
hora exata do início da missão, correspondente ao liftoff. O tempo de parada (Stop)
foi estabelecido em +30 dias, representando a fase de commissioning.

Figura 22 – Cenário Launch.

2. Facility

Para a representação da Base da Força Espacial de Vandenberg em que ocorreu
o lançamento da missão, foi adicionado ao cenário uma instalação por meio das
funções seguintes:

Insert > Insert Default Object > Facility

A imagem a seguir apresenta a janela principal do STK e as funções citadas ante-
riormente:
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Figura 23 – Insert Facility.

Utilizando o ícone de propriedades no Object Browser e renomeando a instalação
para Vandenberg, foram inseridos os dados referentes à localização da base, como
latitude, longitude e altitude, para que ela fosse corretamente posicionada na super-
fície do globo terrestre, como demonstrado na imagem abaixo:

Select Facility > Properties > Basic > Position

Figura 24 – Propriedades da instalação.

3. DART Satellite

A etapa seguinte consistiu em inserir um satélite cuja funcionalidade está em repre-
sentar a sonda e gerar a sua trajetória por meio das configurações de suas proprieda-
des. A DART foi inserida em uma órbita de trajetória interplanetária heliocêntrica



5.2. Estrutura da Simulação 71

e, por isso, o corpo central a ser escolhido deve ser o Sol, conforme demonstrado nos
passos a seguir e na imagem abaixo:

Insert > Insert Default Object > Satellite > Central Body > Sun

Figura 25 – Insert Satellite.

4. Propagator

A função Satellite permite que um propagador seja utilizado como ferramenta de
solução analítica e cálculo numérico para prever a trajetória de um corpo celeste ao
longo do tempo e determinar sua órbita no espaço, com base nas condições iniciais
e nas forças atuantes de acordo com as Leis de Newton. (AGI, 2025)

Os propagadores podem ser analíticos (baixa fidelidade), semi-analíticos (média
fidelidade), e numéricos (alta fidelidade). Os propagadores analíticos fornecem efe-
mérides e vetores de posição e velocidade a partir de soluções diretas das equações de
movimento em função do tempo, sem utilizar métodos numéricos. Os semi-analíticos
aplicam algumas técnicas numéricas para substituir aproximações e os numéricos in-
tegram as equações de movimento numericamente. (AGI, 2025)
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Dentre as opções disponíveis, três propagadores foram considerados neste trabalho
(AGI, 2025):

• TwoBody - Propagador de solução analítica que modela o movimento keple-
riano considerando apenas a força gravitacional da Terra, e portanto, menos
preciso.

• HPOP (High Precision Orbit Propagator) - Propagador numérico de alta pre-
cisão que determina órbitas circulares, elípticas e hiperbólicas em grandes dis-
tâncias além da influência do sistema Terra-Lua, considerando perturbações
externas e influências gravitacionais de vários corpos.

• Astrogator - Método avançado de alta precisão que utiliza o módulo interativo
Mission Control Sequence (MCS) para planejamento e controle de sequências
de missões espaciais, execução de manobras orbitais finitas e impulsivas, e
propagação de trajetórias de veículos espaciais.

Considerando que o objetivo da simulação é gerar a trajetória de lançamento do
foguete transportando a DART até sua inserção em órbita heliocêntrica, e modelar a
trajetória da fase inicial da missão, o Astrogator foi utilizado para definir a sequência
da missão. Assim, renomeando o objeto Satellite para DART, as seguintes funções
foram aplicadas, conforme apresentado nos passos e na imagem abaixo:

Select DART > Properties > Basic > Orbit > Propagator >
Astrogator

Figura 26 – Propagador.

No MCS, a sequência definida para melhor representar os estágios analisados da
missão foi composta por três segmentos: Launch, correspondente ao instante de lif-
toff até o instante de separação do segundo estágio; Spacecraft Separation para
definir a posição inicial da sonda no instante imediatamente anterior à separação
do estágio; Commissioning para propagar a trajetória a partir da posição inicial
até a condição de parada definida como 30 dias após o lançamento.
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Essa sequência é demonstrada nos passos e imagem a seguir:

Insert Segment > Launch

Insert Segment > Initial State > Rename to Spacecraft Separation

Insert Segment > Propagate > Rename to Commissioning

Figura 27 – MCS.

5. Launch

Para as configurações deste segmento foi utilizada a hora exata de decolagem do
foguete às 06:21 UTC do dia 24 de novembro de 2022 como a época de lançamento
(Epoch). Para configurações do local de lançamento, foi utilizada a função Select
Facility para inserir a base de Vandenberg, como observado na imagem a seguir:
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Figura 28 – Launch.

Para as configurações de Burnout, representando o momento em que o combustível é
consumido completamente e os motores do foguete são desligados, foi utilizada uma
aproximação de dados com base no Launch Ground Track da missão (BELLEROSE,
2023). O instante de separação entre estágio e sonda ocorreu às 07:17:20 UTC de
acordo com as efemérides da DART (disponíveis nos anexos), sendo esse instante
adotado como referência para o tempo de voo até o momento da queima completa
de combustível.

A velocidade de Burnout foi calculada considerando que a sonda foi inserida dire-
tamente em órbita heliocêntrica a uma altitude estimada em 300 km, a partir da
equação da velocidade de escape:

𝑣𝑒𝑠𝑐 =
√︃

2𝐺𝑀𝑐𝑜𝑟𝑝𝑜

𝑅
(5.1)
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Os valores utilizados são mostrados na imagem a seguir:

Figura 29 – Burnout.

Para a configuração dos parâmetros do veículo, foi considerado o conjunto foguete
+ sonda como a massa total, utilizando os valores do SpaceX Falcon 9 e da DART,
sendo 549.054 kg para o Falcon 9 e 615 kg para a DART, respectivamente (SPACEX,
2025; NASA, 2023). Para os demais parâmetros foram utilizados os valores padrão
do STK. A imagem abaixo ilustra os valores utilizados:
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Figura 30 – Spacecraft Parameters.

6. Spacecraft Separation

Para esse segmento foi utilizada a primeira efeméride gerada em 2021-11-24 07:17:53.0000
TDB (07:16:43.817 UTC) como condição inicial, determinada pelos vetores po-
sição (X,Y,Z) e velocidade (Vx,Vy,Vz) neste instante de tempo. As coordenadas
cartesianas são geradas no referencial Eclíptica J2000.0 tendo o Sol como corpo
central. Por isso, o sistema de coordenadas deve ser ajustado de acordo com re-
ferencial utilizado, sendo MeanEclpJ2000 o escolhido. A seleção do referencial é
mostrada nos passos e imagens a seguir:

Select Coord. System > ... > Select Reference > Sun >
MeanEclpJ2000
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Figura 31 – Sistema de Coordenadas.

Figura 32 – Referencial.

Considerando que esse segmento ocorre após a separação do foguete, o valor consi-
derado para a massa total nesta etapa foi apenas o da sonda DART, como mostrado
a seguir:
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Figura 33 – Spacecraft Separation Parameters.

7. Commissioning

Este segmento corresponde à propagação da trajetória da DART em 30 dias a partir
da condição inicial pós separação de estágio e inserção em órbita. Considerando
que a órbita é heliocêntrica, é necessário escolher o propagador correspondente. A
condição de parada é determinada como o instante final da propagação de trajetória.
Dentre as opções disponíveis no STK, a condição escolhida foi a duração de 30 dias
para este caso. Os passos necessários para essa configuração são mostrados abaixo:

Select Propagator > ... > Heliocentric

Select Stopping Conditions > Duration
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Figura 34 – Commissioning.

Figura 35 – Propagador Heliocêntrico.
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Figura 36 – Stopping Conditions.

8. Trajetórias Geradas

A partir das etapas descritas anteriormente, as seguintes trajetórias foram geradas
e são apresentadas nas imagens abaixo:

Figura 37 – Trajetória do Falcon 9 em torno da Terra - Vista Superior.
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Figura 38 – Trajetória do Falcon 9 em torno da Terra - Vista Inferior.

Figura 39 – Trajetória Heliocêntrica em torno do Sol.
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Figura 40 – Órbita da DART em torno do Sol.

Figura 41 – Órbita da DART no plano da Eclíptica.
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Figura 42 – Inclinação da Órbita de DART referente ao plano da Eclíptica.

5.2.3 Cruise

Para a simulação da segunda fase da missão utilizou-se procedimentos análogos
aos descritos anteriormente, como apresentados a seguir:

1. Cenário

A criação deste cenário levou em consideração o período da missão que se esten-
deu desde algumas horas após a entrada da sonda em órbita, em 2021-11-24
23:58:50.817 UTC, até o momento final em que a sonda colidiu com o alvo.
De acordo com as efemérides geradas pelo sistema Horizons, foram utilizadas as
seguintes datas e horários, ilustradas na imagem a seguir:

Figura 43 – Configurações do Cenário.
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Considerando que o objetivo é gerar a trajetória durante todo o perído em que
a DART esteve em órbita, é necessário configurar a janela 3D do STK para uma
melhor visualização em grandes distâncias astronômicas, utilizando o Sol como corpo
central. A visualização das órbitas foi ajustada para a orientação do eixo Z do sistema
de coordenadas TrueEclpJ2000. As funções executadas para esta configuração são
demonstradas nos passos a seguir:

Select 3D Graphics Window’s Central Body > Select Sun

Select View From/To > Sun > Direction > Select a Vector > Sun
TrueEclpJ2000.Axes.Z

Select 3D Graphics Window’s Properties > Details > Max. Visible
Distance

As imagens abaixo mostram as ferramentas utilizadas no STK:

Figura 44 – 3D Graphics Window.
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Figura 45 – View From/To.

Figura 46 – Select Vector.
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Figura 47 – 3D Graphics Window’s Properties.

2. Planets

Considerando a extensão da órbita do sistema Didymos-Dimorphos, foram incluídos
na simulação apenas os planetas Mercúrio, Vênus, Terra e Marte, uma vez que
planetas maiores como Júpiter, Saturno, Urano e Netuno estão há distâncias muito
grandes. A função Planet é utilizada para inserir os planetas mencionados no cenário,
como mostrado nos passos e na imagem abaixo:

Select Insert STK Object > Planet > Insert Default

Figura 48 – Insert Planet.

Após essa etapa é necessário configurar as propriedades da função Planet para a
escolha do corpo central, neste caso o planeta em questão:
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Select Planet Properties > Basic > Definition > Select Central Body

A imagem abaixo mostra estas opções:

Figura 49 – Seleção do Planeta.

Para garantir que as órbitas sejam visualizadas adequadamente na janela 3D, são
necessárias as seguintes configurações na opção 3D Graphics > Attributes:

Figura 50 – Configurações do gráfico 3D.

Repetindo os mesmos passos para cada planeta, obtém-se a seguinte imagem na
janela do STK:

Figura 51 – Órbitas dos Planetas.



88 Capítulo 5. Simulações Systems Tool Kit (STK)

3. Didymos

Para inserir a órbita de Didymos, foi utilizada a função Satellite de forma análoga
à descrita na simulação anterior, considerando novamente o Sol como corpo central.
Assim como mencionado anteriormente, um propagador deve ser utilizado para gerar
a trajetória do corpo em questão, e neste caso ambos os propagadores TwoBody e
HPOP foram utilizados, conforme mostrado a seguir:

Select Satellite > Properties > Basic > Orbit > Propagator

De acordo com a base de dados do Horizons System para corpos celestes pequenos,
o período orbital de Didymos é de aproximadamente 2,11 anos (NASA; JPL, 2024).
Com isso, foram utilizadas as seguintes datas para gerar uma órbita completa, bem
como os valores dos vetores posição e velocidade (disponíveis nas efemérides de
Didymos nos anexos), apresentados na imagem abaixo:

Figura 52 – Parâmetros para Didymos.
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4. DART

As funções utilizadas para inserir toda a trajetória da DART ao longo da missão
seguiram os mesmos passos apresentados na simulação anterior, com a diferença de
que não foi necessário adicionar um segmento de lançamento. O módulo utilizado
para esta etapa foi, novamente, o Astrogator, como mostrado na figura abaixo:

Figura 53 – Astrogator.

A configuração do MCS baseou-se nas fases da missão real. Ao longo do período
de voo de 306,7 dias (10 meses), foram realizadas sete manobras orbitais para cor-
rigir operações em voo e a trajetória da sonda, garantindo que ela atingiria o alvo
na posição correta (BELLEROSE, 2023; NASA, 2023). Como simplificação, foram
adotadas apenas três manobras orbitais de correção de trajetória, denominadas Tra-
jectory Correction Maneuvers (TCMs).

A sequência escolhida para o MCS foi definida pelos seguintes segmentos: Initial
State, referente a posição inicial da DART já em órbita; um segmento de propagação
denominado Commissioning, que se estende até a primeira TCM; um segmento
de propagação denominado Cruise, representando o tempo de voo em cruzeiro até
a segunda TCM; um segmento denominado Approach, caracterizando a fase de
aproximação ao sistema binário de Didymos até a terceira TCM; um segmento de
propagação denominado Pre-Impact, representando a fase pré-impacto; e, por fim,
um segmento de parada total denominado STOP no momento exato do impacto.
A imagem abaixo ilustra os segmentos do MCS:
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Figura 54 – Sequências da missão.

As etapas seguintes empregam as mesmas funções utilizadas na simulação anterior,
considerando os vetores posição (X,Y,Z) e velocidade (Vx,Vy,Vz) para a DART no
intervalo de tempo do cenário. As imagens abaixo demonstram essas opções:

Figura 55 – Seleção do Sistema de Coordenadas.
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Figura 56 – Parâmetros da sonda e massa total.

Para as configurações do segmentos seguintes, foram utilizados os seguintes dados:

Manobra Data (UTC) Δ𝑉 (m/s)

TCM-1 04-03-2022 19:00 5,583
TCM-2 17-08-2022 20:00 0,580
TCM-3 09-09-2022 20:00 0,251

Tabela 5 – DART Trajectory Correction Maneuvers. Fonte: (BELLEROSE, 2023)

As configurações de cada segmento foram então utilizadas com os valores apresen-
tados na tabela acima, o propagador Heliocentric, e a função Epoch para definir a
condição de parada por data e hora até o momento exato do impacto. A sequência
de imagens a seguir ilustram essas etapas:
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Figura 57 – Configuração do Commissioning.
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Figura 58 – TCM-1.
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Figura 59 – Configuração do Cruise.
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Figura 60 – TCM-2.
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Figura 61 – Configuração do Approach.
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Figura 62 – TCM-3
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Figura 63 – Configuração do Pre-Impact.
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5. Relatório Final

Para gerar os relatórios finais de análise com os dados referentes as efemérides
geradas pelo STK para as trajetórias de Didymos e da DART, as seguintes funções
foram utilizadas, conforme os passos a seguir:

Select Satellite > Report & Graph Manager

A imagem a seguir mostra as configurações escolhidas, considerando o intervalo
de tempo do cenário, o Step Size de 1 dia, e o referencial J2000 para gerar as
coordenadas cartesianas de posição e velocidade para ambos os corpos:

Figura 64 – Relatório Final.
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6 Resultados e Análise

6.1 Trajetórias Geradas
Através das duas simulações Launch e Cruise realizadas anteriormente, foi possível

gerar as trajetórias e órbitas tanto de Didymos quanto da DART. Para a validação e análise
dos resultados obtidos, é apresentado a seguir um comparativo entre as trajetórias reais
da missão e as geradas pelo STK.

6.1.1 Trajetória de Lançamento

A trajetória de lançamento em solo terrestre desde a base aeroespacial de Van-
denberg até o estágio de separação do segundo estágio do foguete pode ser observada no
Launch Ground Track na imagem a seguir:

Figura 65 – DART Launch Ground Track. Fonte: (BELLEROSE, 2023)

A trajetória gerada pelo STK pode ser observada na imagem a seguir:
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Figura 66 – Trajetória de lançamento gerada pelo STK.

É possível observar que ambas as trajetórias são muito semelhantes nas fases cor-
respondentes às queimas do primeiro e segundo estágios do foguete. Entretanto, o ponto
de separação entre o segundo estágio do foguete e a sonda no mapa real está posicionado
muito mais próximo de Madagascar, na África, aproximadamente nas coordenadas 30ºS,
50ºE, enquanto no mapa gerado pelo STK, esse ponto está mais a sudeste, em torno de
27ºS, 60ºE. Essa diferença pode ser explicada pelo fato de que os parâmetros de lança-
mento utilizados para o cálculo da trajetória foram estimados, uma vez que valores reais
necessários para o cálculo da trajetória como azimute, downrange e altitude, nem sempre
estão disponíveis publicamente.

6.1.2 Órbita de Didymos

Para comparação entre a órbita real do asteroide Didymos e a da gerada pelo STK,
foi utilizada a imagem seguinte extraída da base de dados do Horizons System:
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Figura 67 – Órbita Real de Didymos. Fonte: (NASA; JPL, 2024)

As imagens a seguir ilustram a órbita gerada pelo STK:

Figura 68 – Órbita de Didymos gerada no STK.
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Figura 69 – Inclinação da órbita de Didymos gerada no STK.

É possível observar que a órbita gerada no STK é praticamente idêntica à real, o
que demonstra a precisão dos dados utilizados e das soluções numéricas aplicadas pelos
propagadores.

6.1.3 Trajetória Completa da Missão

A trajetória completa da missão desde a saída da Terra até a chegada no sistema
binário de asteroides pode ser observada na imagem a seguir:
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Figura 70 – Trajetória real da sonda DART. Fonte:(NASA, 2023)

As imagens geradas pelo STK podem ser observadas a seguir em dois momentos
distintos. A cor azul clara representa a órbita da Terra, enquanto as cores verde claro e
roxo representam a órbita da DART:



106 Capítulo 6. Resultados e Análise

Figura 71 – Trajetória final da DART gerada no STK no momento inicial da missão em
2021-11-24 23:58:50.817 UTC.

Figura 72 – Trajetória final da DART gerada no STK no momento do impacto ocorrido
em 2022-09-26 23:14:24.183 UTC.
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Novamente é possível observar a precisão dos dados utilizados e das soluções nu-
méricas aplicadas pelos propagadores, uma vez que a trajetória gerada pelo STK é prati-
camente idêntica à trajetória original da sonda.

6.2 Vetores Posição e Velocidade
O objetivo final das simulações é comparar os parâmetros reais da missão no mo-

mento do impacto, com os dados gerados numericamente pelo STK. Para isso, considera-
se os vetores posição e velocidade no instante da colisão, obtidos nas efemérides geradas
pelo sistema Horizons e nas efemérides calculadas pelo STK (disponíveis nos apêndices).
A sonda DART colidiu com Dimorphos a uma velocidade de aproximadamente 6,14 km/s
no dia 26 de setembro de 2022. (VELEZ, 2023)

Os valores correspondentes aos vetores obtidos a partir das efemérides geradas
pelo sistema Horizons são gerados no referencial Eclíptica J2000.0, cujo plano X-Y é o
plano da eclíptica, enquanto as efemérides calculadas pelo STK são geradas no referencial
J2000 cujo plano X-Y é o plano do equador. (STEREO Science Center, 2024; FRäNZ;
HARPER, 2002)

A tabela abaixo apresenta os valores obtidos:

Tabela 6 – Vetor Posição da sonda DART

Fonte Referencial Hora X (km) Y (km) Z (km)
STK J2000 23:14:24 UTC 155313945,18 20112119,28 -2399087,25

Horizons Eclíptica J2000.0 23:15:33 TDB 154298795,28 13635553,15 -8607687,94

Tabela 7 – Vetor Velocidade da sonda DART
Fonte Referencial Hora Vx (km/s) Vy (km/s) Vz (km/s)
STK J2000 23:14:24 UTC -4,45 25,19 12,40

Horizons Eclíptica J2000.0 23:15:33 TDB -3,77 28,17 0,99

Como os valores obtidos estão em referenciais diferentes, é necessário uma trans-
formação do sistema de coordenadas geocêntrico equatorial J2000 para o sistema eclíptico
heliocêntrico J2000. Considerando que o referencial J2000 está alinhado ao equador e o
Eclíptica J2000.0 ao plano da eclíptica, é necessário considerar a obliquidade entre esses
dois planos, a partir de uma rotação em torno do eixo X equivalente à inclinação da
Terra em relação à eclíptica. Com isso a matriz de transformação entre os sistemas de
coordenadas é dada por (HAPGOOD, 1992; FRäNZ; HARPER, 2002)

⎡⎢⎢⎢⎣
𝑋Ecl

𝑌Ecl

𝑍Ecl

⎤⎥⎥⎥⎦ =

⎡⎢⎢⎢⎣
1 0 0
0 cos 𝜀0 sin 𝜀0

0 − sin 𝜀0 cos 𝜀0

⎤⎥⎥⎥⎦
⎡⎢⎢⎢⎣
𝑋J2000

𝑌J2000

𝑍J2000

⎤⎥⎥⎥⎦
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Em que a obliquidade da eclíptica é dada por:

𝜀0 = 23.439291∘

A partir da matriz de transformação, as coordenadas em J2000 foram convertidas
para Eclíptica J2000, como mostrado na tabela a seguir:

Tabela 8 – Conversão de Coordenadas para Vetor Posição da Sonda DART

Referencial X (km) Y (km) Z (km)
J2000 155313945,18 20112119,28 -2399087,25

Eclíptica J2000 155313945,18 17503821,28 -10200488,36

O mesmo cálculo pode ser realizado para o vetor velocidade utilizando a mesma
matriz de transformação. Os resultados obtidos são mostrados a seguir:

Tabela 9 – Conversão de Coordenadas para Vetor Velocidade da Sonda DART

Referencial Vx (km) Vy (km) Vz (km)
J2000 -4,45 25,19 12,40

Eclíptica J2000 -4,45 28,05 1,36

Considerando os valores convertidos, uma comparação entre os dados obtidos pelo
STK e Horizons pode ser feita no mesmo referencial:

Tabela 10 – Vetor Posição da Sonda DART (Eclíptica J2000.0)

Fonte X (km) Y (km) Z (km)
Horizons 154298795,28 13635553,15 -8607687,94

STK 155313945,18 17503821,28 -10200488,36

Tabela 11 – Vetor Velocidade da Sonda DART (Eclíptica J2000.0)

Fonte X (km/s) Y (km/s) Z (km/s)
Horizons -3,77 28,17 0,99

STK -4,45 28,05 1,36

Com isso, o cálculo do erro relativo entre os dados reais obtidos no Horizons e os
valores obtidos no STK pode ser realizado a partir da equação:

Erro Relativo =
⃒⃒⃒⃒
⃒Valor Estimado − Valor Real

Valor Real

⃒⃒⃒⃒
⃒× 100%

As tabelas abaixo mostram os resultados obtidos:
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Tabela 12 – Erro Relativo para as coordenadas do Vetor Posição

Coordenada Erro Relativo (%)
X 0,65
Y 22,10
Z 15,61

Tabela 13 – Erro Relativo para as coordenadas do Vetor Velocidade

Coordenada Erro Relativo (%)
X 18,04
Y 0,43
Z 37,37

Considerando que os vetores acima são as velocidades heliocêntricas absolutas em
relação ao Sol, e a velocidade de impacto entre a sonda e o asteroide é a velocidade relativa
desses corpos, é possível calcular a velocidade de impacto a partir da diferença entre o
vetor velocidade da DART calculado pelo STK e o vetor velocidade real do asteroide
Dimorphos obtido a partir das efemérides geradas pelo Horizons System no momento
exato da colisão (disponíveis nos anexos). A velocidade relativa pode ser calculada por:

vrelativa = vDART − vDimorphos

E o módulo por:

|vrel| =
√︁

(𝑉𝑥,DART − 𝑉𝑥,Dimorphos)2 + (𝑉𝑦,DART − 𝑉𝑦,Dimorphos)2 + (𝑉𝑧,DART − 𝑉𝑧,Dimorphos)2

Os resultados obtidos são:

Tabela 14 – Vetores de Velocidade da DART e de Dimorphos

Componente DART (km/s) Dimorphos (km/s)
𝑉𝑥 -4,45 -7,32
𝑉𝑦 28,05 33,18
𝑉𝑧 1,36 0,99

O resultado deste cálculo para a velocidade relativa é de 5,89 km/s. Considerando
que o valor real da velocidade de impacto é de 6,14 km/s, o erro relativo pode ser calculado,
resultando em 4,07%.

Apesar dos erros relativos para as coordenadas dos vetores serem consideravel-
mente altos, o erro relativo da velocidade de impacto é bem aceitável. Com base em todas
as análises realizadas anteriormente, é possível concluir que a simulação gerou resultados
coerentes, e demonstrou a missão DART de forma satisfatória.
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7 Conclusão

Ao longo deste trabalho foram discutidas as principais técnicas de defesa planetária
do ponto de vista teórico. É mais do que certo de que a humanidade precisa estar preparada
para situações em que a Terra estará vulnerável aos objetos cósmicos que viajam pelo
Sistema Solar. Embora as probabilidades de colisão com asteroides ou cometas sejam
baixas em um intervalo de tempo que abrange um ciclo de vida humano ou mesmo todo
o período em que a humanidade habita a Terra, elas nunca são nulas, e caso venham a
ocorrer de fato, os danos que podem causar são consideráveis e não podem ser ignorados.
Sendo assim é essencial o desenvolvimento de tecnologias de defesa planetária para a
detecção, observação e caracterização de NEOs, e de técnicas para a mitigação de eventos
em que a Terra corre o risco de colidir com um asteroide ou cometa, de forma que seja
possível, por meio das tecnologias existentes, tirar este objeto da rota de colisão.

Um ponto importante a se considerar no estudo dessas tecnologias de mitigação é o
problema central de deflexão de um asteroide ou cometa, de forma que sua trajetória seja
alterada para que este corpo não encontre a Terra. O estudo da dinâmica orbital desses
corpos é responsável pela fundamentação de modelos matemáticos capazes de determinar
parâmetros importantes e os principais requisitos das missões espaciais para deflexão de
NEOs, como a velocidade de impacto necessária para a alteração da trajetória de um
corpo que esteja viajando no Sistema Solar em direção à Terra, e a deflexão que um corpo
deve sofrer para que a mudança de órbita seja efetiva.

Os modelos matemáticos desenvolvidos ao longo deste trabalho basearam-se nos
problemas clássicos da mecânica orbital que descrevem o movimento dos astros no espaço,
como planetas, estrelas, asteroides e cometas. A fundamentação teórica é essencial para se
entender o problema central e para criar modelos capazes de predizer o comportamento
e eficiência das missões espaciais. Porém, eles estão limitados ao campo teórico, uma
vez que a execução de experimentos laboratoriais que reproduzam os eventos cósmicos é
de dificuldade elevada. Com isso, as simulações computacionais são ótimas opções para o
planejamento e análise de desempenho em missões espaciais de teste. Essas missões são de
extrema importância para que estes modelos matemáticos sejam validados de fato, e para
que a eficiência real das técnicas atualmente discutidas no campo da defesa planetária
seja comprovada.

A missão DART inaugura uma importante era no estudo de objetos próximos à
Terra potencialmente perigosos, e na consolidação de estratégias de defesa planetária, pois
ela foi a primeira oportunidade de uma tecnologia de mitigação ser testada no ambiente
cósmico. Além disso, os investimentos em novas missões de teste podem ser impulsionados
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para que as outras tecnologias de mitigação sejam testadas e validadas. Com os resultados
que foram obtidos da missão, os modelos matemáticos poderão ser aprimorados de forma
que novas tecnologias ainda mais avançadas de defesa planetária sejam desenvolvidas e
implementadas caso haja necessidade.
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8 Trabalhos Futuros

Os trabalhos futuros visam a abordagem dos seguintes tópicos que não foram
aprofundados nos modelos simulados até então:

• Análise da alteração de trajetória e período orbital sofrida por Dimorphos após a
colisão.

• Simulação da missão incluindo Dimorphos no sistema binário de asteroides.

• Simulação do impacto tendo o asteroide alvo como corpo central.

• Análise matemática da colisão com ejeção de massa utilizando os parâmetros reais
da missão.
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APÊNDICE A – Código Python

Listing A.1 – Código utilizado para conversão entre as escalas de tempo UTC e TDB

from astropy.time import Time

def convert_time ():

print("Choose␣the␣conversion␣type:")

print("1:␣Convert␣TDB␣to␣UTC")

print("2:␣Convert␣UTC␣to␣TDB")

choice = input("Enter␣your␣choice␣(1␣or␣2):␣")

if choice == "1":

# User inputs TDB time

tdb_input = input("Enter␣the␣TDB␣time␣(YYYY -MM-DDTHH:MM:

SS):␣")

# Convert TDB to UTC

tdb_time = Time(tdb_input , scale="tdb")

utc_time = tdb_time.utc

print("\nConverted␣Time:")

print("TDB␣Time:", tdb_time.iso)

print("UTC␣Time:", utc_time.iso)

elif choice == "2":

# User inputs UTC time

utc_input = input("Enter␣the␣UTC␣time␣(YYYY -MM-DDTHH:MM:

SS):␣")

# Convert UTC to TDB

utc_time = Time(utc_input , scale="utc")

tdb_time = utc_time.tdb

print("\nConverted␣Time:")

print("UTC␣Time:", utc_time.iso)

print("TDB␣Time:", tdb_time.iso)

else:
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print("Invalid␣choice!␣Please␣enter␣1␣or␣2.")

# Run the function

convert_time ()

def soma(a, b):

return a + b

resultado = soma(5, 10)

print("Resultado:", resultado)
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APÊNDICE B – Efemérides Didymos J2000

Efemérides geradas pelo STK para o vetor posição e velocidade do asteroide Didy-
mos no referencial J2000 utilizando o propagador TwoBody.

Civil Air Patrol Use Only
Satellite-Didymos: J2000 Position & Velocity TwoBody

Time (UTCG) x (km) y (km) z (km) vx (km/sec) vy (km/sec) vz (km/sec)
------------------------ ----------------- ----------------- ----------------- ----------- ----------- -----------
24 Nov 2021 23:58:50.817 -238822018.677034 -220525879.357271 -85265113.325716 12.523432 -8.544539 -4.664375

26 Sep 2022 23:14:24.183 156187215.527259 14929195.734448 -2976486.972744 -7.067000 30.071989 14.103600

Efemérides geradas pelo STK para o vetor posição e velocidade do asteroide Didy-
mos no referencial J2000 utilizando o propagador HPOP.

Civil Air Patrol Use Only
Satellite-Didymos: J2000 Position & Velocity HPOP

Time (UTCG) x (km) y (km) z (km) vx (km/sec) vy (km/sec) vz (km/sec)
------------------------ ----------------- ----------------- ----------------- ----------- ----------- -----------
24 Nov 2021 23:58:50.817 -238822019.025116 -220525879.184566 -85265113.245128 12.523424 -8.544535 -4.664373

26 Sep 2022 23:14:24.183 156158563.040051 14963232.914515 -2955919.183948 -7.077417 30.072815 14.107693
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APÊNDICE C – Efemérides DART J2000

Efemérides geradas pelo STK para o vetor posição e velocidade da sonda DART
no referencial J2000.

Civil Air Patrol Use Only
Satellite-DART: J2000 Position & Velocity

Time (UTCG) x (km) y (km) z (km) vx (km/sec) vy (km/sec) vz (km/sec)
------------------------ ----------------- ----------------- ---------------- ----------- ----------- -----------
24 Nov 2021 23:58:50.817 66555064.0958 120618221.6572 52493603.039 -27.82262 9.865369 6.93797

26 Sep 2022 23:14:24.183 155313945.1794 20112119.2817 -2399087.251 -4.44859 25.187392 12.40255





Anexos
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ANEXO A – Efemérides Didymos - Horizons
System

Efemérides geradas pelo sistema Horizons System para o asteroide Didymos.

******************************************************************
JPL/HORIZONS 65803 Didymos (1996 GT) 2025-Feb-11 10:27:08
Rec #: 65803 (+COV) Soln.date: 2024-Sep-22_23:15:39 # obs: 1647 (2022-2024)

IAU76/J2000 helio. ecliptic osc. elements (au, days, deg., period=Julian yrs):

EPOCH= 2460220. ! 2023-Oct-02.50 (TDB) Residual RMS= .0013278
EC= .3832620488733673 QR= 1.013099326304301 TP= 2459874.313501589
OM= 72.98753451311919 W= 319.580652046918 IN= 3.414166565132348
A= 1.642673885162428 MA= 161.8301594598814 ADIST= 2.272248444020554
PER= 2.1054 N= .468141395 ANGMOM= .02036384
DAN= 1.08484 DDN= 1.97875 L= 32.6184216
B= -2.2129075 MOID= .0397579 TP= 2022-Oct-21.8135015890

Asteroid physical parameters (km, seconds, rotational period in hours):
GM= n.a. RAD= .390 ROTPER= 2.2593
H= 18.1 G= .150 B-V= n.a.

ALBEDO= n.a. STYP= S

ASTEROID comments:
1: soln ref.= JPL#219, PHA OCC=0 radar( 2 delay, 0 Dop.)
2: source=ORB
*******************************************************************************

*******************************************************************************
Ephemeris / WWW_USER Tue Feb 11 10:27:08 2025 Pasadena, USA / Horizons
*******************************************************************************
Target body name: 65803 Didymos (1996 GT) {source: JPL#219}
Center body name: Solar System Barycenter (0) {source: DE441}
Center-site name: BODY CENTER
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*******************************************************************************
Start time : A.D. 2021-Nov-24 00:00:00.0000 TDB
Stop time : A.D. 2022-Sep-26 23:15:33.3650 TDB
Step-size : 1 steps
*******************************************************************************
Center geodetic : 0.0, 0.0, 0.0 {E-lon(deg),Lat(deg),Alt(km)}
Center cylindric: 0.0, 0.0, 0.0 {E-lon(deg),Dxy(km),Dz(km)}
Center radii : (undefined)
Small perturbers: Yes {source: SB441-N16}
Output units : KM-S
Calendar mode : Mixed Julian/Gregorian
Output type : GEOMETRIC cartesian states
Output format : 2 (position and velocity)
Reference frame : Ecliptic of J2000.0
*******************************************************************************
Initial IAU76/J2000 heliocentric ecliptic osculating elements (au, days, deg.):

EPOCH= 2460220. ! 2023-Oct-02.50 (TDB) Residual RMS= .0013278
EC= .3832620488733673 QR= 1.013099326304301 TP= 2459874.313501589
OM= 72.98753451311919 W= 319.580652046918 IN= 3.414166565132348

Equivalent ICRF heliocentric cartesian coordinates (au, au/d):
X=-2.061694865608247E+00 Y=-8.749383735324878E-01 Z=-2.684408670068802E-01

VX= 2.846571000877179E-03 VY=-7.769619147361892E-03 VZ=-3.709229448113573E-03
Asteroid physical parameters (km, seconds, rotational period in hours):

GM= n.a. RAD= .390 ROTPER= 2.2593
H= 18.1 G= .150 B-V= n.a.

ALBEDO= n.a. STYP= S
*******************************************************************************
JDTDB

X Y Z
VX VY VZ

*******************************************************************************
$$SOE
2459542.500000000 = A.D. 2021-Nov-24 00:00:00.0000 TDB
X =-2.399009233081440E+08 Y =-2.354043403722632E+08 Z = 9.566909966915846E+06
VX= 1.245117644061461E+01 VY=-9.766030524772868E+00 VZ=-8.777811821901245E-01

2459849.469136169 = A.D. 2022-Sep-26 23:15:33.3650 TDB
X = 1.542986900109512E+08 Y = 1.363550832440621E+07 Z =-8.607675425033528E+06
VX=-7.323187499736401E+00 VY= 3.318225592379317E+01 VZ= 9.919651943135630E-01

$$EOE
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*******************************************************************************

TIME

Barycentric Dynamical Time ("TDB" or T_eph) output was requested. This
continuous coordinate time is equivalent to the relativistic proper time
of a clock at rest in a reference frame co-moving with the solar system
barycenter but outside the system’s gravity well. It is the independent
variable in the solar system relativistic equations of motion.

TDB runs at a uniform rate of one SI second per second and is independent
of irregularities in Earth’s rotation.

CALENDAR SYSTEM

Mixed calendar mode was active such that calendar dates after AD 1582-Oct-15
(if any) are in the modern Gregorian system. Dates prior to 1582-Oct-5 (if any)
are in the Julian calendar system, which is automatically extended for dates
prior to its adoption on 45-Jan-1 BC. The Julian calendar is useful for
matching historical dates. The Gregorian calendar more accurately corresponds
to the Earth’s orbital motion and seasons. A "Gregorian-only" calendar mode is
available if such physical events are the primary interest.

REFERENCE FRAME AND COORDINATES

Ecliptic at the standard reference epoch

Reference epoch: J2000.0
X-Y plane: adopted Earth orbital plane at the reference epoch

Note: IAU76 obliquity of 84381.448 arcseconds wrt ICRF X-Y plane
X-axis : ICRF
Z-axis : perpendicular to the X-Y plane in the directional (+ or -) sense

of Earth’s north pole at the reference epoch.

Symbol meaning:

JDTDB Julian Day Number, Barycentric Dynamical Time
X X-component of position vector (km)
Y Y-component of position vector (km)
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Z Z-component of position vector (km)
VX X-component of velocity vector (km/sec)
VY Y-component of velocity vector (km/sec)
VZ Z-component of velocity vector (km/sec)

ABERRATIONS AND CORRECTIONS

Geometric state vectors have NO corrections or aberrations applied.

Computations by ...

Solar System Dynamics Group, Horizons On-Line Ephemeris System
4800 Oak Grove Drive, Jet Propulsion Laboratory
Pasadena, CA 91109 USA

General site: https://ssd.jpl.nasa.gov/
Mailing list: https://ssd.jpl.nasa.gov/email_list.html
System news : https://ssd.jpl.nasa.gov/horizons/news.html
User Guide : https://ssd.jpl.nasa.gov/horizons/manual.html
Connect : browser https://ssd.jpl.nasa.gov/horizons/app.html#/x

API https://ssd-api.jpl.nasa.gov/doc/horizons.html
command-line telnet ssd.jpl.nasa.gov 6775
e-mail/batch https://ssd.jpl.nasa.gov/ftp/ssd/hrzn_batch.txt
scripts https://ssd.jpl.nasa.gov/ftp/ssd/SCRIPTS

Author : Jon.D.Giorgini@jpl.nasa.gov
*******************************************************************************



131

ANEXO B – Efemérides DART - Horizons
System

Efemérides geradas pelo sistema Horizons System para a simulação Launch.

*******************************************************************************
Revised: Mar 01, 2024 DART Spacecraft / Sun -135

https://dart.jhuapl.edu/
https://www.nasa.gov/planetarydefense/dart

The Double Asteroid Redirect Test ("DART") is a NASA mission designed to
demonstrate asteroid deflection by kinetic impact.

The spacecraft launched on a SpaceX Falcon 9 rocket out of Vandenberg Space
Force Base in California on 2021-Nov-24 @ 06:21:02 UTC.

SEC01 was 10 minutes after launch. SECO2 was ~20 minutes after that.
Spacecraft/booster separation at 07:17:20 UTC.

BACKGROUND:
DART’s target is the binary asteroid system 65803 Didymos. Not on a path
able to collide with Earth and presenting no hazard, the system is
composed of two asteroids: the primary Didymos, and its smaller moonlet
satellite asteroid, Dimorphos, which orbits Didymos at a distance of
about 1.18 km every 11.92 hours.

DART will autonomously navigate the last 4 hours to impact the moonlet
Dimorphos nearly head-on in the fall of 2022, when ~11 million kilometers
from Earth, shortening the time it takes to orbit the primary body Didymos
by several minutes.

Since the Didymos system is an eclipsing binary as viewed from Earth,
Dimorphos passes in front of and behind Didymos, changing its brightness.
Ground-based telescopes on Earth will be able to use this to assess the
before/after effect caused by DART’s impact at 6.6 km/s, producing data
useful to "planetary defense" modeling.
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The LICIACube camera system will be deployed prior to impact and travel
past the asteroid roughly three minutes after DART impacts to confirm the
impact, document the spread of the resulting dust plume, attempt to capture
an image of the newly formed crater and the opposite side of Dimorphos.

KEY EVENT TIMES
Launch: 24-Nov-2021 06:21:02 UTC
Impact: 26-Sep-2022 23:14:24.183 UTC (actual)

PHYSICAL CHARACTERISTICS:
Main bus
- box, dimensions ~ 1.2 x 1.3 x 1.3 meters, from which other structures

extend to result in measurements of ~1.8 meters width, 1.9 meters length,
2.6 meters in height.

- Two large solar panel arrays on each side, each 8.5 m long when deployed

SCIENCE INSTRUMENTS:
- DRACO: "Didymos Reconnaissance and Asteroid Camera for Optical navigation"

A high-resolution imager derived from the New Horizons LORRI camera to
support navigation and targeting, measure size and shape of the target,
determine the impact site and geologic context.

- LICIACube: "Light Italian Cubesat for Imaging of Asteroids"
Deployed Sep. 12 UTC prior to the DART impact, LICIACube (6U) will capture
images of the DART impact, resulting ejecta cloud, and potentially the
impact crater on the surface of Dimorphos.

TRAJECTORY:
NOTE: Final reconstructed trajectory

The mission-reconstructed DART trajectory can be used as an observing center
(use ’@’ prefix ) OR as a target (drop the ’@’).

Related objects:

@ -210 (LICIACube spacecraft)
@ 20065803 (65803 Didymos system barycenter, pre-computed JPL s205)
@ 920065803 (Didymos primary center, reconstructed JPL s542)
@ 120065803 (Dimorphos, satellite of Didymos, reconstructed JPL s542)
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To instead numerically integrate the latest JPL ground-based solution for the
Didymos system barycenter, request "65803;" (or select from menu list). The
integrated database version can only be used as a target, not an observing
center.

Name Start (TDB) Stop (TDB)
------------------------------ ---------------------- ----------------------
dart_2021_328_2022_091_rec_v01 2021-Nov-24 07:17:53.0 2022-Apr-01 00:00:00.0
dart_2022_091_2022_231_rec_v01 2022-Apr-01 00:00:00.0 2022-Aug-19 00:01:09.2
dart_2022_231_2022_269_rec_v03 2022-Aug-19 00:01:09.2 2022-Sep-26 22:00:00.0
dart_2022_269_2022_269_rec_v03 2022-Sep-26 22:00:00.0 2022-Sep-26 23:14:45.3
dart_2022_269_2022_269_spc_v04 2022-Sep-26 23:14:45.3 2022 SEP 26 23:15:33.4
dart_2022_269_2099_001_imp_v03 2022-Sep-26 23:15:33.4 2099-Jan-01 00:00:99.0

*******************************************************************************

*******************************************************************************
Ephemeris / WWW_USER Sun Feb 9 16:01:06 2025 Pasadena, USA / Horizons
*******************************************************************************
Target body name: DART (spacecraft) (-135) {source: dart_v03_hrzn}
Center body name: Solar System Barycenter (0) {source: DE441}
Center-site name: BODY CENTER
*******************************************************************************
Start time : A.D. 2021-Nov-24 07:17:53.0000 TDB
Stop time : A.D. 2022-Sep-26 23:15:33.1820 TDB
Step-size : 1440 minutes
*******************************************************************************
Center geodetic : 0.0, 0.0, 0.0 {E-lon(deg),Lat(deg),Alt(km)}
Center cylindric: 0.0, 0.0, 0.0 {E-lon(deg),Dxy(km),Dz(km)}
Center radii : (undefined)
Output units : KM-S
Calendar mode : Mixed Julian/Gregorian
Output type : GEOMETRIC cartesian states
Output format : 2 (position and velocity)
Reference frame : Ecliptic of J2000.0
*******************************************************************************
JDTDB

X Y Z
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VX VY VZ
*******************************************************************************
$$SOE
2459542.804085648 = A.D. 2021-Nov-24 07:17:53.0000 TDB
X = 6.824101646604043E+07 Y = 1.308544499883843E+08 Z = 1.520696586282551E+04
VX=-3.069990826235598E+01 VY= 8.117587395960179E+00 VZ= 3.958077478236036E+00

2459848.804085648 = A.D. 2022-Sep-26 07:17:53.0000 TDB
X = 1.545053328902389E+08 Y = 1.201523683791980E+07 Z =-8.672406368364304E+06
VX=-3.439493438700035E+00 VY= 2.821121305909671E+01 VZ= 1.117616719580724E+00

$$EOE
*******************************************************************************

TIME

Barycentric Dynamical Time ("TDB" or T_eph) output was requested. This
continuous coordinate time is equivalent to the relativistic proper time
of a clock at rest in a reference frame co-moving with the solar system
barycenter but outside the system’s gravity well. It is the independent
variable in the solar system relativistic equations of motion.

TDB runs at a uniform rate of one SI second per second and is independent
of irregularities in Earth’s rotation.

CALENDAR SYSTEM

Mixed calendar mode was active such that calendar dates after AD 1582-Oct-15
(if any) are in the modern Gregorian system. Dates prior to 1582-Oct-5 (if any)
are in the Julian calendar system, which is automatically extended for dates
prior to its adoption on 45-Jan-1 BC. The Julian calendar is useful for
matching historical dates. The Gregorian calendar more accurately corresponds
to the Earth’s orbital motion and seasons. A "Gregorian-only" calendar mode is
available if such physical events are the primary interest.

REFERENCE FRAME AND COORDINATES

Ecliptic at the standard reference epoch

Reference epoch: J2000.0
X-Y plane: adopted Earth orbital plane at the reference epoch
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Note: IAU76 obliquity of 84381.448 arcseconds wrt ICRF X-Y plane
X-axis : ICRF
Z-axis : perpendicular to the X-Y plane in the directional (+ or -) sense

of Earth’s north pole at the reference epoch.

Symbol meaning:

JDTDB Julian Day Number, Barycentric Dynamical Time
X X-component of position vector (km)
Y Y-component of position vector (km)
Z Z-component of position vector (km)
VX X-component of velocity vector (km/sec)
VY Y-component of velocity vector (km/sec)
VZ Z-component of velocity vector (km/sec)

ABERRATIONS AND CORRECTIONS

Geometric state vectors have NO corrections or aberrations applied.

Computations by ...

Solar System Dynamics Group, Horizons On-Line Ephemeris System
4800 Oak Grove Drive, Jet Propulsion Laboratory
Pasadena, CA 91109 USA

General site: https://ssd.jpl.nasa.gov/
Mailing list: https://ssd.jpl.nasa.gov/email_list.html
System news : https://ssd.jpl.nasa.gov/horizons/news.html
User Guide : https://ssd.jpl.nasa.gov/horizons/manual.html
Connect : browser https://ssd.jpl.nasa.gov/horizons/app.html#/x

API https://ssd-api.jpl.nasa.gov/doc/horizons.html
command-line telnet ssd.jpl.nasa.gov 6775
e-mail/batch https://ssd.jpl.nasa.gov/ftp/ssd/hrzn_batch.txt
scripts https://ssd.jpl.nasa.gov/ftp/ssd/SCRIPTS

Author : Jon.D.Giorgini@jpl.nasa.gov
*******************************************************************************
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Efemérides geradas pelo sistema Horizons System para a simulação Cruise.

*******************************************************************************
Revised: Mar 01, 2024 DART Spacecraft / Sun -135

https://dart.jhuapl.edu/
https://www.nasa.gov/planetarydefense/dart

The Double Asteroid Redirect Test ("DART") is a NASA mission designed to
demonstrate asteroid deflection by kinetic impact.

The spacecraft launched on a SpaceX Falcon 9 rocket out of Vandenberg Space
Force Base in California on 2021-Nov-24 @ 06:21:02 UTC.

SEC01 was 10 minutes after launch. SECO2 was ~20 minutes after that.
Spacecraft/booster separation at 07:17:20 UTC.

BACKGROUND:
DART’s target is the binary asteroid system 65803 Didymos. Not on a path
able to collide with Earth and presenting no hazard, the system is
composed of two asteroids: the primary Didymos, and its smaller moonlet
satellite asteroid, Dimorphos, which orbits Didymos at a distance of
about 1.18 km every 11.92 hours.

DART will autonomously navigate the last 4 hours to impact the moonlet
Dimorphos nearly head-on in the fall of 2022, when ~11 million kilometers
from Earth, shortening the time it takes to orbit the primary body Didymos
by several minutes.

Since the Didymos system is an eclipsing binary as viewed from Earth,
Dimorphos passes in front of and behind Didymos, changing its brightness.
Ground-based telescopes on Earth will be able to use this to assess the
before/after effect caused by DART’s impact at 6.6 km/s, producing data
useful to "planetary defense" modeling.

The LICIACube camera system will be deployed prior to impact and travel
past the asteroid roughly three minutes after DART impacts to confirm the
impact, document the spread of the resulting dust plume, attempt to capture
an image of the newly formed crater and the opposite side of Dimorphos.
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KEY EVENT TIMES
Launch: 24-Nov-2021 06:21:02 UTC
Impact: 26-Sep-2022 23:14:24.183 UTC (actual)

PHYSICAL CHARACTERISTICS:
Main bus
- box, dimensions ~ 1.2 x 1.3 x 1.3 meters, from which other structures

extend to result in measurements of ~1.8 meters width, 1.9 meters length,
2.6 meters in height.

- Two large solar panel arrays on each side, each 8.5 m long when deployed

SCIENCE INSTRUMENTS:
- DRACO: "Didymos Reconnaissance and Asteroid Camera for Optical navigation"

A high-resolution imager derived from the New Horizons LORRI camera to
support navigation and targeting, measure size and shape of the target,
determine the impact site and geologic context.

- LICIACube: "Light Italian Cubesat for Imaging of Asteroids"
Deployed Sep. 12 UTC prior to the DART impact, LICIACube (6U) will capture
images of the DART impact, resulting ejecta cloud, and potentially the
impact crater on the surface of Dimorphos.

TRAJECTORY:
NOTE: Final reconstructed trajectory

The mission-reconstructed DART trajectory can be used as an observing center
(use ’@’ prefix ) OR as a target (drop the ’@’).

Related objects:

@ -210 (LICIACube spacecraft)
@ 20065803 (65803 Didymos system barycenter, pre-computed JPL s205)
@ 920065803 (Didymos primary center, reconstructed JPL s542)
@ 120065803 (Dimorphos, satellite of Didymos, reconstructed JPL s542)

To instead numerically integrate the latest JPL ground-based solution for the
Didymos system barycenter, request "65803;" (or select from menu list). The
integrated database version can only be used as a target, not an observing
center.
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Name Start (TDB) Stop (TDB)
------------------------------ ---------------------- ----------------------
dart_2021_328_2022_091_rec_v01 2021-Nov-24 07:17:53.0 2022-Apr-01 00:00:00.0
dart_2022_091_2022_231_rec_v01 2022-Apr-01 00:00:00.0 2022-Aug-19 00:01:09.2
dart_2022_231_2022_269_rec_v03 2022-Aug-19 00:01:09.2 2022-Sep-26 22:00:00.0
dart_2022_269_2022_269_rec_v03 2022-Sep-26 22:00:00.0 2022-Sep-26 23:14:45.3
dart_2022_269_2022_269_spc_v04 2022-Sep-26 23:14:45.3 2022 SEP 26 23:15:33.4
dart_2022_269_2099_001_imp_v03 2022-Sep-26 23:15:33.4 2099-Jan-01 00:00:99.0

*******************************************************************************

*******************************************************************************
Ephemeris / WWW_USER Tue Feb 11 10:09:19 2025 Pasadena, USA / Horizons
*******************************************************************************
Target body name: DART (spacecraft) (-135) {source: dart_v03_hrzn}
Center body name: Solar System Barycenter (0) {source: DE441}
Center-site name: BODY CENTER
*******************************************************************************
Start time : A.D. 2021-Nov-25 00:00:00.0000 TDB
Stop time : A.D. 2022-Sep-26 23:15:33.3650 TDB
Step-size : 1 steps
*******************************************************************************
Center geodetic : 0.0, 0.0, 0.0 {E-lon(deg),Lat(deg),Alt(km)}
Center cylindric: 0.0, 0.0, 0.0 {E-lon(deg),Dxy(km),Dz(km)}
Center radii : (undefined)
Output units : KM-S
Calendar mode : Mixed Julian/Gregorian
Output type : GEOMETRIC cartesian states
Output format : 2 (position and velocity)
Reference frame : Ecliptic of J2000.0
*******************************************************************************
JDTDB

X Y Z
VX VY VZ

*******************************************************************************
$$SOE
2459543.500000000 = A.D. 2021-Nov-25 00:00:00.0000 TDB
X = 6.655505908371053E+07 Y = 1.315458082086132E+08 Z = 1.864556230749711E+05
VX=-2.782262238227311E+01 VY= 1.181099753790447E+01 VZ= 2.441576918478349E+00
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2459849.469136169 = A.D. 2022-Sep-26 23:15:33.3650 TDB
X = 1.542987952772332E+08 Y = 1.363555314643420E+07 Z =-8.607687938160306E+06
VX=-3.771479427816498E+00 VY= 2.816810937688586E+01 VZ= 9.978892269866115E-01

$$EOE
*******************************************************************************

TIME

Barycentric Dynamical Time ("TDB" or T_eph) output was requested. This
continuous coordinate time is equivalent to the relativistic proper time
of a clock at rest in a reference frame co-moving with the solar system
barycenter but outside the system’s gravity well. It is the independent
variable in the solar system relativistic equations of motion.

TDB runs at a uniform rate of one SI second per second and is independent
of irregularities in Earth’s rotation.

CALENDAR SYSTEM

Mixed calendar mode was active such that calendar dates after AD 1582-Oct-15
(if any) are in the modern Gregorian system. Dates prior to 1582-Oct-5 (if any)
are in the Julian calendar system, which is automatically extended for dates
prior to its adoption on 45-Jan-1 BC. The Julian calendar is useful for
matching historical dates. The Gregorian calendar more accurately corresponds
to the Earth’s orbital motion and seasons. A "Gregorian-only" calendar mode is
available if such physical events are the primary interest.

REFERENCE FRAME AND COORDINATES

Ecliptic at the standard reference epoch

Reference epoch: J2000.0
X-Y plane: adopted Earth orbital plane at the reference epoch

Note: IAU76 obliquity of 84381.448 arcseconds wrt ICRF X-Y plane
X-axis : ICRF
Z-axis : perpendicular to the X-Y plane in the directional (+ or -) sense

of Earth’s north pole at the reference epoch.

Symbol meaning:
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JDTDB Julian Day Number, Barycentric Dynamical Time
X X-component of position vector (km)
Y Y-component of position vector (km)
Z Z-component of position vector (km)
VX X-component of velocity vector (km/sec)
VY Y-component of velocity vector (km/sec)
VZ Z-component of velocity vector (km/sec)

ABERRATIONS AND CORRECTIONS

Geometric state vectors have NO corrections or aberrations applied.

Computations by ...

Solar System Dynamics Group, Horizons On-Line Ephemeris System
4800 Oak Grove Drive, Jet Propulsion Laboratory
Pasadena, CA 91109 USA

General site: https://ssd.jpl.nasa.gov/
Mailing list: https://ssd.jpl.nasa.gov/email_list.html
System news : https://ssd.jpl.nasa.gov/horizons/news.html
User Guide : https://ssd.jpl.nasa.gov/horizons/manual.html
Connect : browser https://ssd.jpl.nasa.gov/horizons/app.html#/x

API https://ssd-api.jpl.nasa.gov/doc/horizons.html
command-line telnet ssd.jpl.nasa.gov 6775
e-mail/batch https://ssd.jpl.nasa.gov/ftp/ssd/hrzn_batch.txt
scripts https://ssd.jpl.nasa.gov/ftp/ssd/SCRIPTS

Author : Jon.D.Giorgini@jpl.nasa.gov
*******************************************************************************
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ANEXO C – Efemérides Dimorphos -
Horizons System

Efemérides geradas pelo sistema Horizons System para o asteroide Dimorphos.

******************************************************************
JPL/HORIZONS Dimorphos (Didymos I) 120065803
Updated: 2024-Mar-01 Solution (s542) date: 2023-Sep-19

This is the DART mission’s post-impact reconstructed trajectory for Dimorphos,
-satellite- of the 65803 Didymos system & the IMPACTED TARGET.

The trajectory data includes the pre- and post-impact ephemeris for Dimorphos.
For surface cartographic locations, pre- and post-impact Dimorphos rotation
models are used automatically.

To use Dimorphos as a coordinate origin, set center to "@ 120065803".

DART impact was on 26-Sep-2022 @ 23:14:24.183 UTC, equivalent to 2022-Sep-26
23:15:33.365359 TDB.

Related objects:
DART spacecraft : -135 (mission navigation)
LICIACube spacecraft : -210 (mission navigation)
Didymos system barycenter : 20065803 (JPL s205 mission reconstruction)

65803; (latest JPL ground-based solution)
Didymos primary body : 920065803 (JPL s542 reconstruction)

Dimorphos physical parameters:
Radii ~ (0.09078 x 0.06932 x 0.06131) km, 145.6 m volume equivalent diam.
Volume ~ 0.001616 km^3
GM_Dimo ~ 2.98047E-10 km^3/s^2

Possible Dimorphos mass-ejection (0.1-0.5%) is not reflected here,
perhaps measured later by follow-on ESA mission Hera.

Pre-impact Dimorphos spin pole (ICRF at J2000.0 epoch, east long. positive)
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RA = 69.32686 deg. (310.0 deg. ecliptic longitude)
DEC = -72.72455 deg. (-80.6 deg. ecliptic latitude)
PM = 73.07056508 deg., 724.7243883 deg/day, 1.0271E-06 deg^2/day^2

(period is 11.92177 hrs)

Post-impact Dimorphos spin pole
A dynamic frame where the X axis points from Dimorphos center to Didymos
center. The Z axis is parallel to the pre-impact Z axis.
RA = 69.32686 deg. (310.0 deg. ecliptic longitude)
DEC = -72.72455 deg. (-80.6 deg. ecliptic latitude)

Name Start (TDB) Stop (TDB)
--------------------------------------- ----------------- -----------------
didymos_system_s542_v01 2000-Jan-01 00:00 2024-Dec-31 00:00

*******************************************************************************

*******************************************************************************
Ephemeris / WWW_USER Thu Feb 13 01:43:26 2025 Pasadena, USA / Horizons
*******************************************************************************
Target body name: Dimorphos (120065803) {source: dart_v03_hrzn}
Center body name: Solar System Barycenter (0) {source: DE441}
Center-site name: BODY CENTER
*******************************************************************************
Start time : A.D. 2021-Nov-24 07:17:53.0000 TDB
Stop time : A.D. 2022-Sep-26 23:15:33.3650 TDB
Step-size : 1 steps
*******************************************************************************
Center geodetic : 0.0, 0.0, 0.0 {E-lon(deg),Lat(deg),Alt(km)}
Center cylindric: 0.0, 0.0, 0.0 {E-lon(deg),Dxy(km),Dz(km)}
Center radii : (undefined)
Output units : KM-S
Calendar mode : Mixed Julian/Gregorian
Output type : GEOMETRIC cartesian states
Output format : 2 (position and velocity)
Reference frame : Ecliptic of J2000.0
*******************************************************************************
JDTDB

X Y Z
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VX VY VZ
*******************************************************************************
$$SOE
2459542.804085648 = A.D. 2021-Nov-24 07:17:53.0000 TDB
X =-2.395733969478891E+08 Y =-2.356605935764344E+08 Z = 9.543823782669157E+06
VX= 1.247315307990838E+01 VY=-9.744442832337249E+00 VZ=-8.786387846377277E-01

2459849.469136169 = A.D. 2022-Sep-26 23:15:33.3650 TDB
X = 1.542987953461447E+08 Y = 1.363555308959103E+07 Z =-8.607687937956400E+06
VX=-7.323308286627445E+00 VY= 3.318237490840047E+01 VZ= 9.919372986353743E-01

$$EOE
*******************************************************************************

TIME

Barycentric Dynamical Time ("TDB" or T_eph) output was requested. This
continuous coordinate time is equivalent to the relativistic proper time
of a clock at rest in a reference frame co-moving with the solar system
barycenter but outside the system’s gravity well. It is the independent
variable in the solar system relativistic equations of motion.

TDB runs at a uniform rate of one SI second per second and is independent
of irregularities in Earth’s rotation.

CALENDAR SYSTEM

Mixed calendar mode was active such that calendar dates after AD 1582-Oct-15
(if any) are in the modern Gregorian system. Dates prior to 1582-Oct-5 (if any)
are in the Julian calendar system, which is automatically extended for dates
prior to its adoption on 45-Jan-1 BC. The Julian calendar is useful for
matching historical dates. The Gregorian calendar more accurately corresponds
to the Earth’s orbital motion and seasons. A "Gregorian-only" calendar mode is
available if such physical events are the primary interest.

REFERENCE FRAME AND COORDINATES

Ecliptic at the standard reference epoch

Reference epoch: J2000.0
X-Y plane: adopted Earth orbital plane at the reference epoch
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Note: IAU76 obliquity of 84381.448 arcseconds wrt ICRF X-Y plane
X-axis : ICRF
Z-axis : perpendicular to the X-Y plane in the directional (+ or -) sense

of Earth’s north pole at the reference epoch.

Symbol meaning:

JDTDB Julian Day Number, Barycentric Dynamical Time
X X-component of position vector (km)
Y Y-component of position vector (km)
Z Z-component of position vector (km)
VX X-component of velocity vector (km/sec)
VY Y-component of velocity vector (km/sec)
VZ Z-component of velocity vector (km/sec)

ABERRATIONS AND CORRECTIONS

Geometric state vectors have NO corrections or aberrations applied.

Computations by ...

Solar System Dynamics Group, Horizons On-Line Ephemeris System
4800 Oak Grove Drive, Jet Propulsion Laboratory
Pasadena, CA 91109 USA

General site: https://ssd.jpl.nasa.gov/
Mailing list: https://ssd.jpl.nasa.gov/email_list.html
System news : https://ssd.jpl.nasa.gov/horizons/news.html
User Guide : https://ssd.jpl.nasa.gov/horizons/manual.html
Connect : browser https://ssd.jpl.nasa.gov/horizons/app.html#/x

API https://ssd-api.jpl.nasa.gov/doc/horizons.html
command-line telnet ssd.jpl.nasa.gov 6775
e-mail/batch https://ssd.jpl.nasa.gov/ftp/ssd/hrzn_batch.txt
scripts https://ssd.jpl.nasa.gov/ftp/ssd/SCRIPTS

Author : Jon.D.Giorgini@jpl.nasa.gov
*******************************************************************************


